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Using This Book

Audience

This documentation is intended primarily for users who are responsible for
implementing SAS Marketing Operations Management. The intended audience
includes users who are responsible for installing, configuring, and administering
SAS Marketing Operations Management. Examples of users include system
administrators, database administrators, and high-level risk-management
personnel. The scope of this documentation is focused on the administrative
tasks that these users are likely to perform. This documentation assumes users
have familiarity with the technical terminology and concepts that are required to
perform these tasks.
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System and Software Configuration

Supported System Configurations
Third-Party Software

Client Requirements
Pre-installation Checklist

Port Communication

Configure Communication between Web Services and
SAS MOM Dashboard Service

Configure Communication between Web Services and
Media Server to SAS MOM Plug-in Service

Configure Communication between the Media Processor
for InDesign and the InDesign CS5.5 or CS6 Server

Configure Communication between Solutions and Web
Services to SAS MOM Business Events Service

Supported System Configurations

SAS Marketing Operations Management is supported on the following system

configurations, which can consist of one to four servers.

© © o0 I O

10

11

11

In a given configuration, you need to select one or more components while you
are installing SAS Marketing Operations Management on an individual server in
the configuration. The installer components that you select depend on the tiers

that the server will host.
The installation consists of the following five tiers:
application tier
web server tier
cataloger tier
media processor tier

database tier

The installer has components that relate to the first four tiers. You do not need to

run the installer for the database tier.

This document applies to the following system configurations that consist of the

following servers:
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Solutions Server
Hosts the web server tier.

Web Services Server
Hosts the application tier.

Cataloger Server
Hosts the cataloger tier.

Media Processor

Hosts the media processor tier.

Database Server
Hosts the database tier.

Third-Party Software

Install the following third-party software on the specified servers before you
install SAS Marketing Operations Management 6.4. Contact Technical Support
for the location of the installers for the following software. The names of the
installer packages are mentioned in the following table:

Table 1.1 Installer Packages for Third-Party Software

Software

Windows Server
2008 R2 SP1 (64
Bit) or Windows
Server 2012 R2
(STANDARD
EDITION)
(LOCALE EN-
uUs)

I1IS7.50n
Windows Server
2008 R2 SP1 or
11IS 8.5 0n
Windows Server
2012 R2

MSMQ
v6.3.9600.16384
for Windows
Server 2012
MSMQ
v6.1.7600.16385
for Windows
Server 2008 R2
SP1

Web Solution Cataloge Media
Service s Server rServer Serve

S r
Server

Y Y Y Y
Y Y Y Y
Y Y Y Y

Databas
e Server

Media MS Medi
Process  Office a

or for Server Gene
InDesign rator
Y for Y Y
2008 R2

SP1only

Y Y Y

Y Y Y

Media
Proce
ssor
for
FLV
Gener
ator

Y
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.NET Framework Y Y Y Y Y Y Y Y
4.5.1 (To be

installed on

Windows Server

2008 R2 SP1)

MSXML 4.0SP3 Y Y Y Y

Parser (msxml

4.0 SP3.msi)

Microsoft SQL Y Y Y Y Y

Server System
CLR Types (x64)
(Version
10.50.1600.1)
(SQLSysClIrType
s.msi)

Microsoft SQL Y Y Y Y Y
Server 2008 R2

Management

Objects (x64)

(Version

10.50.1600.1)

(SharedManage

mentObjects.msi

)

Access Y Y Y
Database Engine
x64 2010
(Version
14.0.4763.1000)
(AccessDatabas
eEngine_x64.ex
e) or Microsoft
Access 2013
Runtime (Version
15.0.4517.1004)
(AccessRuntime
_en-us_x64.exe)

Microsoft WSE Y Y Y Y Y Y Y Y Y
3.0 (Microsoft

WSE 3.0.msi)

Microsoft SQL Y

Server 2008 R2
or SQL Server
2012 SP1
(Standard
Edition)

Adobe Acrobat X Y
and Xl

Professional

Edition

Microsoft Visual Y Y Y Y Y Y Y Y
C++ 2008

Redistributable -

x64

9.0.30729.17

(veredist_x64.ex

e)
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SAP Crystal
Reports runtime
engine for .NET
Framework (64-
bit)

Microsoft Office
2010 or
Microsoft Office
2013 x64-bit
(Standard or
Professional)

ImageMagick:
6.8.9-4-Q16-x64
(ImageMagick-6.
8.9-4-Q16-x64-
dil.exe)

ASP.NET State
Service version
4.0.30319.33440

Adobe InDesign
CS 5.50r CS6
server (required
only if Artwork
Producer is
deployed)

GPL Ghostscript
(http://
downloads.ghost
script.com/
public/
gs914w64.exe)
Ghostscript: 9.14

Y

Consider the following when you are installing the software that is listed in this
table:

Install Microsoft Office on a separate server in the network or on any one of
the other servers (provided that the servers are within the firewall).

SAS Marketing Operations Management Security Recommendations:
You should use Transport Layer Security (TLS) in order to have a secure
browser connection with the SAS Marketing Operations Management web
server. This requirement guards against session fixation, theft of user
credentials, and other attacks that depend on inspecting and forging the data
exchanged between the web browser and the web server.

While you are installing Access Database Engine x64, ensure that no 32-bit
version of Microsoft Office components are installed.

You need to disable the dialog boxes for online updates and software
registration for Adobe Acrobat after you install it. Refer to “Suppress Dialog
Boxes for Automatic Updates” on page 61 for more information.

Install the Windows component Messaging Queuing Service with HTTP
support enabled.

You should use Microsoft SQL Server 2012 SP1.



Table 1.2

Software

Windows Server 2008 R2 SP1 (64
Bit) or Windows Server 2012 R2
(STANDARD EDITION) (LOCALE
EN-US)

IIS 7.5 on Windows Server 2008
R2 SP1 or IIS 8.5 on Windows
Server 2012 R2

MSMQ v6.3.9600.16384 for
Windows Server 2012 MSMQ
v6.1.7600.16385 for Windows
Server 2008

.NET Framework 4.5.1 (To be
installed on Windows Server 2008
R2 SP1)

MSXML 4.0 SP3 Parser (msxml
4.0 SP3.msi)

Microsoft SQL Server System CLR
Types (x64) (Version
10.50.1600.1)
(SQLSysClrTypes.msi)

Microsoft SQL Server 2008 R2
Management Objects (x64)
(Version 10.50.1600.1)
(SharedManagementObjects.msi)

Access Database Engine x64
2010 (Version 14.0.4763.1000)
(AccessDatabaseEngine_x64.exe)
Or Microsoft Access 2013 Runtime
(Version 15.0.4517.1004)
(AccessRuntime_en-us_x64.exe)

Microsoft WSE 3.0 (Microsoft WSE
3.0.msi)

Microsoft SQL Server 2008 R2 or
SQL Server 2012 SP1 (Standard
Edition)

Installer Packages and Their Usage

How Obtained

License required.

Comes with Windows server.

Comes with Windows server.

Freely downloadable.

Freely downloadable.

Redistributed via the Cl Clearing
House as a part of packaged pre-
requisite software (as a ZIP file)
required to be installed before
installing Marketing Operations
Management 6.4.

Redistributed via the CI Clearing
House as a part of Packaged pre-
requisite software (as a ZIP file)
required to be installed before
installing Marketing Operations
Management 6.4 ZIP file.

Redistributed via the SAS
Marketing Operations
Management package.

Redistributed via the SAS
Marketing Operations
Management package.

License required.

Third-Party Software

Usage

Used by the operating system

Used by the web server.

Used for sending messages via
queues by all modules in SAS
Marketing Operations
Management.

.NET required by application.

Required for XML processing.
Used by all modules.

Executing database script files.

Executing database script files.

Reading Microsoft Excel using
OLE DB

Used to transfer binary files across
machines. Used by application
server and web services. Used for
encryption and decryption of
database connection strings,
passwords, and URL parameters.

Used by the database for SAS
Marketing Operations
Management.
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Adobe Acrobat X and XI
Professional Edition

Microsoft Visual C++ 2008
Redistributable - x64 9.0.30729.17
(vcredist_x64.exe)

SAP Crystal Reports runtime
engine for .NET Framework (64-
bit) (Go to http://scn.sap.com/docs/
DOC-7824. Download the
64bit.msi for version 13.0.6.1027
CRRuntime_64bit_13_0_6.msi.). If
the link is not available on this site,
then contact SAP to get this
version.

Microsoft Office 2010 or Microsoft
Office 2013 x64-bit (Standard or
Professional)

ImageMagick: 6.8.9-4-Q16-x64
(ImageMagick-6.8.9-4-Q16-x64-
dll.exe)

ASP.NET State Service version
4.0.30319.33440

Adobe InDesign CS 5.5 OR CS6
server (required only if Artwork
Producer is deployed)

GPL Ghostscript (http:/
downloads.ghostscript.com/public/
gs914w64.exe) Ghostscript: 9.14

License required.

Redistributed via the SAS
Marketing Operations
Management package.

Freely downloadable.

License required.

Redistributed via the SAS
Marketing Operations
Management package.

Comes with .NET framework.

License required.

Freely downloadable.

Client Requirements

The following software is required on the client:

Adobe Acrobat is required on the
Microsoft Office Processor.

Note: If SAS Marketing
Operations Management Media
annotations is not used for
approvals, a per-user Adobe
License for all users of approvals
should be purchased.)

Executing C++ COM DLLs

Required for generating reports.

Used for consolidating comments
by approvals tasks and jobs, and
for importing and exporting Excel
by all modules.

Used to generate previews and
thumbnails for digital assets in the
Digital Library.

Required along with .NET.

Used by Artwork Producer
(required only if Artwork Producer
is deployed and you are using
InDesign templates).

Used along with ImageMagick for
media file processing by the Digital
Library.

Windows: Microsoft Windows 7 or Microsoft Windows 8

Macintosh: Snow Leopard 10.6.8

Browsers: Internet Explorer 9.0 or later (Windows 32- and 64-bit), Firefox
12.0 or later (Windows 64-bit), Google Chrome 15.0 or later (Windows 64-bit)
or Safari 5.1.5 or later (Macintosh).


http://scn.sap.com/docs/DOC-7824
http://scn.sap.com/docs/DOC-7824
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Note: Disable the pop-up blocker on the browsers that you use for SAS
Marketing Operations Management.

Adobe Acrobat X or Xl Professional, Standard, or Reader: For offline
approvals.

Microsoft Office 2007, 2010, or 2013: For opening office documents
(reports) and adding comments to Microsoft Word and Microsoft Excel
documents during approval.

Adobe Flash Player 11.1 or later: For viewing the dashboard channels,
media annotations, resource manager and artwork producer, and so on.

Adobe AIR 13.0: For using the SAS Marketing Operations Management
desktop.

Pre-installation Checklist

Check for the following before you install SAS Marketing Operations
Management:

1 List of third-party software that is required, including the licensed software.
2 Port communication. List of ports that need to be open on the servers

Hardware requirements.

h @

SQL Server configuration.

a

[IS settings.

o

ASP.NET state service start-up.

Port Communication

The Port on which you complete the installation should be open on all the
servers on which SAS Marketing Operations Management is installed.

Configure Communication between Web Services
and SAS MOM Dashboard Service

SAS MOM Dashboard service is a Windows service. This service generates the

SAS Marketing Operations Management dashboard for each tenant. By default,

the web services machine communicates with the SAS MOM Dashboard service
using TCP on port number 16601.

You can configure an alternative port number in the
DashboardService.exe.config file. This file is available in the Installation
Folder\Binaries folder on the web services machine.
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Figure 1.1 Port Communication between Web Services and SAS MOM Dashboard

Service
SAS MOM
Weh TCP: 16601
. Dashboard
Services .
Service

To configure an alternative port:

1 Open the DashboardService.exe.config file and search for the following
node:

<add key="TCPChannelPortNumber" value="16601"/>
2 Update value with the new port number.

3 Open the Web.config file. This file is available in the Installation Folder
\ALServices folder on the web services machine. Search for the following
node:

<add key="DashboardServiceHost" value="tcp://localhost:16601 /DashboardGenerator"/>
4 Update value with the new port number.

5 Restart the SAS MOM Dashboard service.

Configure Communication between Web Services
and Media Server to SAS MOM Plug-in Service

SAS MOM plug-in service is a Windows service. This service is used to invoke
the plug-ins that are registered for the service. By default, the web service and
media server communicate with the plug-in service using TCP on port number
16602.

You can configure an alternative port number in the PluginService.exe.config
file. This file is available in the Installation Folder\Binaries folder on the
web services machine and on the Media Server machine.

Figure 1.2 Port Communication between Web Services and Media Server and SAS
MOM Plug-in Service

Web

Services TCP: 16602 | SAS MOM

and Media Plugin

Server Service

To configure an alternative port:

1 Open the PluginService.exe.config file and search for the following node:

<add key="TCPChannelPortNumber" value="16602"/>
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2 Update value with the new port number.

3 Open the Web.config file. This file is available in the Installation Folder
\ALServices folder on the web services machine. Search for the following
node:

<add key="PluginServiceHost" value="tcp://localhost:16602 /PlugineServer"/>

4 Update value with the new port number.

5 Restart the SAS MOM Plug-in Service after you change the port number on
the web services machine and on the Media Server machine.

Configure Communication between the Media
Processor for InDesign and the InDesign CS5.5 or

CS6 Server

The Media Processor for the InDesign machine communicates with the InDesign
CS5.5 or CS6 server using HTTP on port number 16603. The InDesign CS5.5 or
CS6 Server is used to generate artwork. The artwork is used by the Artwork
Producer.

You can configure an alternative port number in the InDesignCS3_Config.xml
file. This file is located in the Installation Folder\Configuration\XML
folder on the Media Processor for InDesign machine and on the web services
machine.

To configure an alternative port:

1 Open the InDesignCS3_Config.xml file and search for the following nodes:

<ARGUMENTS>-port 16603</ARGUMENTS>
<INDESIGNWEBSERVICEURL>
http://localhost:16603
</INDESIGNWEBSERVICEURL>

2 Update the port number.

3 In the Task Manager, end the InDesign Server process. Restart the SAS
MOM Queue Manager Service on the Media Processor for InDesign machine
and on the web services machine.

Configure Communication between Solutions and
Web Services to SAS MOM Business Events

Service

The Business Events service is a windows service. SAS MOM Business Events
service is used to track changes for entities and facets. The solutions machine
and the web services machine communicate with the SAS MOM Business
Events service using TCP on port number 16605.

You can configure an alternative port number in the
BusinessEventsService.exe.config file. This file is located in the Installation
Folder\Binaries folder on the Solutions machine and on the web services
machine.
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Figure 1.3 Port Communication between Solutions and Web Services and SAS MOM

Business Events Service

SA5 MOM

Solutions TCP: 16605 Business

and Web

Events
Service

Services

To configure an alternative port:

1

Open the BusinessEventsService.exe.config file and search for the following
node:

<add key="TCPChannelPortNumber" value="16605"/>
Update value with the new port number.

Open the Web.config file. This file is available in the Installation Folder
\ALServices folder on the web services machine. This file is also available
inthe Installation Folder\Tenant Name folder on the Solutions
machine. You must configure the port in both Web.config files. Search for the
following node:

<add key ="BusinessEventsTCPChannelPortNumber" value="16605"/>
Update value with the new port number.

Restart SAS MOM Business Events Service after you change the port
number on the solutions machine and on the web services machine.
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Pre-installation Tasks

Set Up Roles and Features on Windows 2012
Set Up Roles and Features on Windows 2008

Installing Third-Party Software
Install the MSXML 4.0 SP3 Parser
Install the Microsoft SQL Server System CLR Types (x64)
Install the Microsoft SQL Server 2008 R2 Management Objects (x64)
Install the Microsoft Access Database Engine 2010 x64
Install Microsoft Access 2013 Runtime
Install Microsoft WSE 3.0
Install Microsoft Visual C++ 2008 Redistributable - x64 9.0.30729.17
Install the SAP Crystal Reports Runtime Engine for .NET
Framework (64-bit)
Install ImageMagick 6.8.9-4-Q16-x64
Install GPL Ghostscript

For SAS Marketing Operations Management Desktop

Configuring the SQL Server
Set Up the Communication Protocol
Set the Time-out for Query Execution
Create a Database User Login Account in SQL Server

Verify IIS Settings
Start ASP.Net State Service

Set Up Roles and Features on Windows
2012

To set up roles and features on Windows 2012:

1 Open Server Manager. In the left navigation pane, click Dashboard.

13
14

15
15
16
16
16
17
17
17

17
18
18

18

19
19
19
20

21
21

2 Inthe right pane, click Add roles and features. The Add Roles and Features

Wizard appears.
3 On the Before You Begin page, click Next.

4 On the Select Installation Type page, select Role-based or feature-based
installation. Click Next.
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5

On the Select Destination Server page, select Select a server from the
server pool, and then select a server from the Server Pool list. Click Next.

On the Select Server Roles page, select Web Server (lIS) from the list of
Roles. Click Next.

On the Select Features page, select the following options from the Features
list, and then click Next.

.NET Framework 3.5 (includes .NET 2.0 and 3.0)
ASP.NET 4.5

HTTP Activation

Message Queuing Services

HTTP Support

On the Web Server Role (lIS) page, click Next.

On the Select Role Services page, select Dynamic Content Compression,
Basic Authentication, and Windows Authentication from the Role
services list. Click Next.

10 On the Confirm Installation Selections page, click Install.

11 The Installation Progress page shows the installation progress. After the

installation is complete, click Close to close the Add Roles and Features
Wizard.

Set Up Roles and Features on Windows

2008

To set up the roles and features on Windows 2008:

1

Open Server Manager. In the left navigation pane, right-click Roles, and then
select Add Roles.

On the Before You Begin page, click Next. The Add Roles Wizard appears.
On the Select Server Roles page, select Web Server (lIS) and click Next.
On the Web Server (IIS) page, click Next.

On the Select Roles Services page, select the following roles:
Common Http Features: Select all the features.

Application Development: Select ASP.NET, .NET Extensibility, ASP,
CGl, ISAPI Extensions, and ISAPI Filters.

Health and Diagnostics: Select HTTP Logging, Request Monitor, and
Request Filtering.

Performance: Select Static Content Compression.

Management Tools: Select IIS Management Console. Under IIS 6
Management Compatibility, select IS 6 Metabase Compatibility.



7

8

Installing Third-Party Software 15
FTP Publishing Service: Select all the features.
Click Next.
On the Confirmation page, click Next.
On the Progress page, click Next.

On the Installation Results page, click Close.

Set up the features by completing the following steps:

To set up features on Windows 2008:

1

Open the Server Manager. In the left navigation pane, right-click Features,
and then select Add Features. The Add Features Wizard appears.

On the Select Features page, select the following features:
.NET Framework 3.0 Features (Installed): Select all the features.
WCF Activation: Select all the features.

Message Queuing: Select Message Queuing Server and HTTP
Support.

Click Next.

On the Web Server (lIS) page, click Next.
On the Roles Services page, click Next.
On the Progress page, click Next.

On the Installation Results page, click Close.

Installing Third-Party Software

Install the MSXML 4.0 SP3 Parser
To install the MSXML 4.0 SP3 parser:

1

2

Run the MSXML 4.0 SP3.msi file. The Setup Wizard appears.

On the End-User License Agreement page, read and accept the terms in the
license agreement, and then click Next.

On the Customer Information page, enter your user name and organization
name, and then click Next.

On the Choose Setup Type page, click Install Now.

After the installation is complete, click Finish to close the Setup Wizard.
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Install the Microsoft SQL Server System CLR

Types (x64)

To install Microsoft SQL Server System CLR Types (x64):

1

Run the SQLSysCIrTypes.msi file. The Installation Wizard appears. Click
Next.

On the License Agreement page, read and accept the terms in the license
agreement, and then click Next.

On the Registration Information page, enter your user name and organization
name, and then click Next.

On the Ready to Install the Program page, click Install.

After the installation is complete, click Finish to close the Installation Wizard.

Install the Microsoft SQL Server 2008 R2
Management Objects (x64)

To install the Microsoft SQL Server 2008 R2 Management Objects (x64):

1

Run the SharedManagementObjects.msi file. The Installation Wizard
appears. Click Next.

On the License Agreement page, read and accept the terms in the license
agreement, and then click Next.

On the Registration Information page, enter your user name and organization
name, and then click Next.

On the Ready to Install the Program page, click Install.

After the installation is complete, click Finish to close the Installation Wizard.

Install the Microsoft Access Database Engine

2010 x64

Note: Install Microsoft Access Database Engine x64 2010 when Microsoft
Office 2010 x64-bit is installed. Ensure that no 32-bit version of MS Office
components are installed.

To install the Access Database Engine x64 2010:

1

2

Run the AccessDatabaseEngine_x64.exe file.

Read and accept the terms in the license agreement, and then click
Continue.

After the installation is complete, click Close to close the Installation Wizard.
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Install Microsoft Access 2013 Runtime

Note: Install Microsoft Access 2013 Runtime when Microsoft Office 2013 x64-bit
is installed. Ensure that no Microsoft Office 32-bit components are installed.

To install Microsoft Access 2013 Runtime:

1

2

Run the AccessRuntime_en-us_x64.exe file.

Read and accept the terms in the license agreement, and then click
Continue.

After the installation is complete, click Close to close the Installation Wizard.

Install Microsoft WSE 3.0
To install Microsoft WSE 3.0:

1

Run the Microsoft WSE 3.0.msi file. The Installation Wizard appears. Click
Next.

On the License Agreement page, read and accept the terms in the license
agreement, and then click Next.

On the Setup Type page, select Runtime setup type (default), and then click
Next.

On the Ready to Install the Program page, click Install.

After the installation is complete, click Finish to close the Installation Wizard.

Install Microsoft Visual C++ 2008 Redistributable
- x64 9.0.30729.17

To install Microsoft Visual C++ 2008 Redistributable - x64 9.0.30729.17:

1

2

Run the vcredist_x64.exe file. The Installation Wizard appears. Click Next.

On the License Terms page, read and accept the license terms, and then
click Install.

After the installation is complete, click Finish to close the Installation Wizard.

Install the SAP Crystal Reports Runtime Engine
for .NET Framework (64-bit)

To install the SAP Crystal Reports runtime engine for .NET Framework (64-bit):

1

Run the CRRuntime_64bit_13_0_6.msi file. The Installation Wizard appears.
Click Next.

2 On the License Agreement page, read and accept the license terms, and

then click Next.
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3

4

On the Start Installation page, click Next.

After the installation is complete, click Finish to close the Installation Wizard.

Install ImageMagick 6.8.9-4-Q16-x64
To install ImageMagick 6.8.9-4-Q16-x64:

1

Run the ImageMagick-6.8.9-4-Q16-x64-dll.exe file. The Setup Wizard
appears. Click Next.

On the License Agreement page, read and accept the license terms, and
click Next.

On the Information page, read the instructions, and click Next.

On the Select Destination Location page, specify the location for the
installation, and click Next.

On the Select Start Menu Folder page, specify the location where the
program’s shortcut should be created. Click Next.

On the Select Additional Tasks page, select Create a desktop icon and Add
application directory to your system path, and clickNext.

On the Ready to Install page, click Install.

After the installation in complete, the Information page shows the instructions
for verifying the installation. To continue with the setup, click Next.

After the setup is complete, click Finish to close the Setup Wizard.

Install GPL Ghostscript
To install GPL Ghostscript:

1

2

Click http://downloads.ghostscript.com/public/gs914w64.exe.
In the self-extractor dialog box, click Setup.

In the GPL Ghostscript Setup dialog box, specify the locations for
installation and shortcuts. Click Install.

For SAS Marketing Operations
Management Desktop

SAS Marketing Operations Management Desktop is an extended part of the
SAS Marketing Operations Management solution, which is built on the AIR
platform from Adobe. The Desktop helps catalog digital data in bulk or batch into
the Digital Library. You can easily associate metadata or business information
with it (which is not possible through the web-based solution).


http://ghostscript.com/releases/gs871w64.exe

Configuring the SQL Server 19

File Sharing:

1

The Desktop connects to the Cataloger Server to transfer the selected files to
catalog into the SAS Marketing Operations Management system.

The Desktop then connects to the Solution Server to validate the user and
retrieve the section hierarchy the user has access to.

System Requirements for using the Desktop:

Ensure that a minimum of 5 MB disk space is available.

To deploy the SAS Marketing Operations Management Desktop on the end-
user desktop machine, you must connect to the SAS Marketing Operations
Management web server and the cataloger machine. Either the machine’s IP
address or its DNS name should be publicly visible via the Internet.

Configuring the SQL Server

Set Up the Communication Protocol

To set up the communication protocol for the SQL server:

1

2

Open SQL Server Configuration Manager.

Expand SQL Native Client Configuration, and select the Client Protocols
option.

Enable the TCP/IP protocol.

Set the Time-out for Query Execution

To set the query execution time-out for the SQL server to 0 (that is, to be
infinite):

1

2

Open Microsoft SQL Server Management Studio.

Connect to the database server by supplying the appropriate credentials.
Select Tools Menu » Options.

In the tree view, expand Query Execution » SQL Server.

Click SQL Server. A list of settings is displayed. Set the value of the
execution time-out to 0. Save the setting.

Close all instances of SQL Server Management Studio and restart the SQL
Server (MSSQLSERVER) from the Services panel.
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Create a Database User Login Account in SQL
Server

To create a SAS Marketing Operations Management database user login
account in SQL Server:

1 Launch SQL Server Management Studio.
2 Expand the Security folder in the left pane.

3 Right-click Logins and select New Login. The Login - New dialog box
appears.

Display 2.1 Login-New Dialog Box

E Login - New M[=] E3
Selectapa ‘E;s Script - u Help
%A General
%4 Server Floles :
1 User Mapping Login narme: |SASMEIM Seanzh... |
A Securables  Wwindows authentication
A
[ Status {* SOL Server authentication
Pazzword: I""“"'
Confirm password: I""“"'

El Specify old password

0ld pazzword: I

™ {Erfarce password policy:

™| Erforce passward expiration

™ User must change password &t nest [ogin

" Mapped to certificate I j
" Mapped to asymmetric key I j
™ Map to Credential I ﬂ A
tapped Credentials Credential Prowider I
Server
RD
Connection:

A

4¢ View connection properties

Reay Default database: Imaster |

Default language: |<dEfEIU|l> |

aF I Cahcel |

4

4 Specify the following information in the Login - New dialog box:
a Enter the login name.

b Select SQL Server authentication and enter the password for this login.
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c Clear the Enforce password expiration check box.

d Select master as the default database.

Verify IIS Settings

Ensure that the web service extensions section for the default website allows
ASP.NET for version v4.0.30319. Go to the Internet Information Service (1IS)
Manager, click on the <Server Name> item in the Connections menu on the left
pane. In the IS section, double-click the ISAPI and CGI Restrictions icon.

Ensure that Al1lowed is set for ASP.NET v4.0.30319 for 64 bit.

Display 2.2 ISAPI and CGI Restrictions

Ugl ISAPI and CGI Restrictions

Use this Feature ko specify the ISAPT and CGI extensions that can run on the Web server,

Group by: Mo Grouping =

Description = I Restriction I Path

{[Mo Descripkion] Allowed i Windows\system32\MOISE. DLL

Active Server Pages Allowed Chwindows\system32\inetsrvasp.di

ASP.MET w2.0,50727 Allowed i windowsi Microsoft, NET\Frameworke4w2 0,507 27\ aspnet_isapi.dll
ASP.MET w2.0.50727 Allowwed i\ windowsi Microsoft, NET\Frameworki vz, 0.50727 \aspnet_isapi.dl
ASP.MET w4.0.30319 Allowed C\windowsi Microsoft, NET\Framework w4, 0.30319aspnet_isapi.dl
ASP.MET w4.0.30319 Allowwed C i windowsi Microsoft, NET\Frameworkedwd, 0,503 19 aspnet_isapi.dll
WebDay Allowed ChWindowsisystem32\inetsrviwebday. dil

Start ASP.Net State Service

Start the ASP.Net State Service if it is not already started. Ensure that the start-
up type for this service is automatic.
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Installing SAS Marketing Operations
Management

Initial Steps

If you are installing an individual server in the target configuration, you might
need to select one installer component or multiple installer components. How
many you select is dependent on which tiers are to be hosted on that server.
During the installation process, the installation folder is created and a
SASMOMTools folder is created on the same drive. You must restart every
server after the installation process is complete.

You can install SAS Marketing Operations Management application on a single
server or on multiple servers.

Note: This documentation refers to the user that is used for the installation as
MOMUSR, which can be either the local system user or the domain user.

-

In the SAS Software Depot, double-click Setup.
2 Select the language, and click OK.

3 On the Select Deployment Task page, select Install SAS software. Click
Next.

4 On the Specify SAS Home page, select the SAS home folder. Click Next.

5 On the Select Products to Install page, select SAS Marketing Operations
Management, and click Next.

6 On the Select Regional Settings page, select English for the locale, and click
Next.

7 Depending on whether you want a single-machine installation or a multiple-
machine installation, perform the relevant steps:
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For single-machine installation, see “Additional Steps for a Single-
Machine Installation” on page 24.

For multiple-machine installation, see “Additional Steps for a Multiple-
Machine Installation” on page 25.

Additional Steps for a Single-Machine Installation

Before you begin the following task, complete the steps described in “Initial
Steps” on page 23.

1

9

On the SAS Marketing Operations Management Setup page, select all the
components that you want to install. Click Browse to select the destination
folder, and then click Next.

Note: If you anticipate high usage of video files, the Media Processor for
FLV generator should be on an independent machine because a
considerable amount of memory is required. If you do not install it on a
separate machine, all the other requests might be delayed.

On the Specify User Type page, select the domain user or the local system
user. Enter the user name and password, and click Next. The password for
the local system user must meet the password policy requirements for the
local machine. The local system user is created during the installation
process. The domain user must belong to the administrators group on the
local machine.

On the Server Details page, enter the server name or the IP address of the
machines on which Solutions, Web Services, and Media Server are installed.
Select a communication protocol, enter the DNS name or IP address for
access via Internet and the port number, and click Next. The default port
number for HTTP is 80 and for HTTPS is 443.

On the Number of Catalogers page, select No for the Will this be set up
with two catalogers field. Click Next. On the Catalogers Details page, enter
the cataloger server name or |IP address.

Note: In a single-machine configuration, there can be only one cataloger.

On the Additional Server Details page, enter the name or IP address for the
machines on which Media Generator, FLV Generator, MSOffice Processor,
and InDesign Processor are installed, and click Next.

In the Port Number window, enter the internal port number.

On the Script Execution page, choose how you want to execute the scripts,
and then click Next. The script is executed only when you are migrating the
system to a newer version and not for an initial installation. Continue with the
default selection.

On the E-mail Information page, enter the first name, last name, and email
address of the user who will receive email notifications from the system.

After the file system check is complete, click Next.

10 On the Deployment Summary page, click Start.

11 After the installation is complete, click Next. On the next page, click Finish to

close the SAS Deployment Wizard.
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Additional Steps for a Multiple-Machine
Installation

Prerequisites

Run the SAS Deployment Wizard on each machine in the configuration. All the
components need to be installed on the same drive and on the same network.
The password for the MOMUSR should be the same on all the machines.

The following figure shows a sample deployment of SAS Marketing Operations
Management on multiple servers. The figure shows a deployment that uses two
catalogers, primary and secondary. If you are using only one cataloger, then you
need to install the primary cataloger on the Cataloger Server.

Display 3.1 Suggested Deployment Scenario

Suggested Deployment Scenario

Solutions (Web Servar Web Services

Tier) (Application Tier)
Cataloger (Primary) Microsoft Office
Cataloger Server

{5‘9'?"“"“"!'1 Media Processor for
Media Server InDesign

Media Generator

Madia Processor for FLV

Generator

Install Solutions and Primary Cataloger on the Web Server
Tier

If you are installing only one cataloger, you must install that cataloger on the
Cataloger Server, not on the web server tier.

To install solutions and the primary cataloger (in a two-cataloger deployment) on
the web server tier:

1 On the SAS Marketing Operations Management Setup page, select
Solutions and Cataloger. Click Browse to select the destination folder, and
then click Next.

2 On the Specify User Type page, select the domain user or the local system
user. Enter the user name and password, and click Next. The password for
the local system user must meet the password policy requirements of the
local machine. The local system user is created during the installation
process. The domain user must belong to the administrators group on the
local machine. Make sure you enter the same user credentials on all the
machines in the configuration.

3 On the Server Details page, enter the server name or the IP address of the
machines on which Solutions, Web Services, and Media Server are installed.
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Select a communication protocol, enter the DNS name or IP address for
access via Internet and the port number, and click Next. The default port
number for HTTP is 80 and for HTTPS is 443. The default port number for
HTTP is 80 and for HTTPS is 443. Make sure you select the same
communication protocol and enter the same port number on all the machines
in the configuration.

4 On the Number of Catalogers page:

If you are installing two catalogers, select Yes for the Will this be set up
with two catalogers field. Click Next.

If you are installing only one cataloger, select No for the Will this be set
up with two catalogers field. Click Next.

5 On the Cataloger Details page, enter the cataloger details and specify
whether this machine is the primary cataloger. Click Next.

6 On the Additional Server Details page, enter the name or IP address for the
machines on which Media Generator, FLV Generator, MSOffice Processor,
and InDesign Processor are installed. Select whether these servers are
accessible through a UNC path, and click Next.

7 In the Port Number window, enter the internal port number. Make sure the
port number is the same on all machines.

8 After the file system check is complete, click Next.
9 When you are prompted for a reboot, click Allow.

10 After the installation is complete, click Next. On the next page, click Finish to
close the SAS Deployment Wizard.

Install Web Services and Microsoft Office Processor

1 On the SAS Marketing Operations Management Setup page, select Web
Services and Microsoft Office Processor. Click Browse to select the
destination folder, and then click Next.

2 On the Specify User Type page, select the domain user or the local system
user. Enter the user name and password, and click Next. The password for
the local system user must meet the password policy requirements of the
local machine. The local system user is created during the installation
process. The domain user must belong to the administrators group on the
local machine. Make sure you enter the same user credentials on all the
machines in the configuration.

3 On the Server Details page, enter the server name or the IP address of the
machines on which Solutions, Web Services, and Media Server are installed.
Select a communication protocol, enter the DNS name or IP address for
access via Internet and the port number, and click Next. The default port
number for HTTP is 80 and for HTTPS is 443. Make sure you select the
same communication protocol and enter the same port number on all the
machines in the configuration.

4 On the Number of Catalogers page:

If you are installing two catalogers, select Yes for the Will this be set up
with two catalogers field. Click Next.
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If you are installing only one cataloger, select No for the Will this be set
up with two catalogers field. Click Next.

5 On the Cataloger Details page, enter the cataloger details, and then click
Next.

6 On the Additional Server Details page, enter the name or IP address for the
machines on which Media Generator, FLV Generator, MSOffice Processor,
and InDesign Processor are installed, and click Next.

7 In the Port Number window, enter the internal port number. Make sure the
port number is the same on all machines.

8 On the Script Execution page, choose how you want to execute the scripts,
and then click Next. The script is executed only when you are migrating the
system to a newer version and not for an initial installation. Continue with the
default selection.

9 On the E-mail Information page, enter the first name, last name, and email
address of the user who will receive email notifications from the system.

10 After the file system check is complete, click Next.
11 On the Deployment Summary page, click Start.
12 When you are prompted for a reboot, click Allow.

13 After the installation is complete, click Next. On the next page, click Finish to
close the SAS Deployment Wizard.

Install Secondary (or Only) Cataloger, Media Server, Media
Generator, and Media Processor for FLV Generator

If you are installing only one cataloger, you must install that cataloger on this tier.

1 On the SAS Marketing Operations Management Setup page, select
Cataloger, Media Processor for FLV Generator, Media Server, and Media
Generator. Click Browse to select the destination folder, and then click
Next.

2 On the Specify User Type page, select the domain user or the local system
user. Enter the user name and password, and click Next. The password for
the local system user must meet the password policy requirements of the
local machine. The local system user is created during the installation
process. The domain user must belong to the administrators group on the
local machine. Make sure you enter the same user credentials on all the
machines in the configuration.

3 On the Server Details page, enter the server name or the IP address of the
machines on which Solutions, Web Services, and Media Server are installed.
Select a communication protocol, enter the DNS name or IP address for
access via Internet and the port number, and click Next. The default port
number for HTTP is 80 and for HTTPS is 443. Make sure you select the
same communication protocol and enter the same port number on all the
machines in the configuration.

4 On the Number of Catalogers page:

If you are installing two catalogers, select Yes for the Will this be set up
with two catalogers field. Click Next.
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9

If you are installing only one cataloger, select No for the Will this be set
up with two catalogers field. Click Next.

On the Cataloger Details page, enter the cataloger details and specify
whether this machine is the primary cataloger. Click Next.

On the Additional Server Details page, enter the name or IP address for the
machines on which Media Generator, FLV Generator, MSOffice Processor,
and InDesign Processor are installed. Select whether these servers are
accessible through a UNC path and click Next.

In the Port Number window, enter the internal port number. Make sure the
port number is the same on all machines.

On the E-mail Information page, enter the first name, last name, and email
address of the user who will receive email notifications from the system.

After the file system check is complete, click Next.

10 After the installation is complete, click Finish to close the SAS Deployment

Wizard.

Note: When you have completed the installation, restart the machine. If you are
installing SAS Marketing Operations Management on multiple machines, restart
each machine after installation.

Install Media Processor for InDesign

1

On the SAS Marketing Operations Management Setup page, select Media
Processor for InDesign. Click Browse to select the destination folder, and
then click Next.

On the Server Details page, enter the server name or the IP address of the
machines on which Solutions, Web Services, and Media Server are installed.
Select a communication protocol, enter the DNS Name or IP address for
access via Internet and the port number, and click Next. The default port
number for HTTP is 80 and for HTTPS is 443. Make sure you select the
same communication protocol and enter the same port number on all the
machines in the configuration.

On the Number of Catalogers page:

If you are installing two catalogers, select Yes for the Will this be set up
with two catalogers field. Click Next.

If you are installing only one cataloger, select No for the Will this be set
up with two catalogers field. Click Next.

On the Cataloger Details page, enter the cataloger details and specify
whether this machine is the primary cataloger. Click Next.

On the Additional Server Details page, enter the name or IP address for the
machines on which Media Generator, FLV Generator, MSOffice Processor,
and InDesign Processor are installed, and click Next.

In the Port Number window, enter the internal port number. Make sure the
port number is the same on all machines.

On the E-mail Information page, enter the first name, last name, and email
address of the user who will receive email notifications from the system.
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8 After the file system check is complete, click Next.

9 After the installation is complete, click Finish to close the SAS Deployment
Wizard.

Note: When you have completed the installation, restart the machine. If you are
installing SAS Marketing Operations Management on multiple machines, restart
each machine after installation.
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After you complete the installation, restart the machine. If you have performed a
multi-machine installation, restart each machine after the installation process is
complete. Refer to SAS Marketing Operations Management: Quick Start Guide
for a quick installation verification and application functionality validation.

After the installation is completed, check the log files for any exceptions. The log
files (InstallationSettingsLog.txt and CreateTenant_Tenant Name.txt) are stored
under the Installation folder on the machine.

Confirm Installation of Windows Services

The Windows services are installed on all the servers where SAS Marketing
Operations Management is installed. Go to the services panel by clicking on
Start » Administrative Tools » Server Manager, and then click the Services
item. Right-click each service and start the service. The installer sets the service
to automatic and sets the selected services to run under the MOMUSR account.

Note: If any of the services are not installed, launch the InstallServices.bat file
located under <Installation Path>/Binaries and refer to“Running a
Service under the MOMUSR Context” on page 78 for more information. The
Installation folder is in the location that you specified when you installed SAS
Marketing Operations Management.

Note: You can start the SAS MOM Cataloger and SAS MOM File Watcher
services only after you have set the mount points for a tenant. You set the mount
points after you create the tenant. See “Create the Tenant” on page 39.

The DAM Job copy service and Replication service are required only if you are
using a setup where an external setup is available. These two services are not
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Table 4.1 Services

Services

SAS MOM Back-
Office Service

SAS MOM
Dashboard Service

SAS MOM
Notification Service

SAS MOM Text
Cataloger Service

SAS MOM Queue
Manager Service

SAS MOM
Cataloger Service

installed by the installer, and you need to install them manually. To install these
services, run the following batch files, which are located at <Installation
folder>/Binaries:

InstallDAMJobCopyServices.bat: Install this service on the network machine
on which the cataloger mount point for external setup is configured.

InstallReplicationAgentServices.bat: Install this service on the solutions

machine.

Confirm successful installation of all the following services by launching the

Services applet from the Administrative Tools control panel:

Note: You can start the services mentioned in the table in any order.

.exe File

ALBackOfficeServic
e.exe

ALDashboardServi
ce.exe

ALNotificationServi
ce.exe

ALTextCatalogerSe
rvice.exe

ALQueueManager
Service.exe

ALCatalogerServic
e.exe

User Account

Local System

Local System

Local System

Local System

MOMUSR

MOMUSR

Component

Web Services

Web Services

Web Services

Web Services

All components.

Cataloger

Description

This service
executes back-end
processes at a
specified time daily
within SAS
Marketing
Operations
Management for
each tenant.

This service
generates the SAS
Marketing
Operations
Management
dashboard for each
tenant.

This service sends
e-mail notifications
to the SAS
Marketing
Operations
Management
users.

This service
extracts text from
specific searchable
files and make it
available for text
searches.

This service is used
to process the
messages added in
SAS Marketing
Operations
Management
queues.

This service
processes the
catalog jobs for
each tenant.
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SAS MOM File
Watcher Service

SAS MOM Format
Watcher Service

SAS MOM
PluginService
Service

SAS MOM
BusinessEvents
Service

SAS MOM Report
Scheduler

SAS MOM Service
Monitor

SAS MOM NTFS
Monitoring Service

.exe File

ALFileWatcherServi
ce.exe

ALFormatWatcherS
ervice.exe

ALPluginService.ex
e

ALBusinessEvents

Service.exe

ALReportScheduler
.exe

ALServiceMonitor.e
xe

ALNTFSMonitoring
Service.exe

User Account

MOMUSR

Local System

MOMUSR

MOMUSR

Local System

MOMUSR

Local System
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Component

Cataloger

Solutions

Web Services,
Media Server

Solutions, web
Services

Web Services

All the Machines

Web Services

Description

This service
monitors the
cataloger mount
point on the arrival
of a new catalog
job for each tenant.

This service
monitors the format
watcher mount
point for a new
format job and
processes it for
each tenant. This
service is used for
the Artwork
Producer.

This service
invokes the plug-
ins that are
registered for the
service.

This service is used
to track changes for
entities and facets.

This service sends
scheduled SAS
Marketing
Operations
Management
reports.

This service
monitors other SAS
Marketing
Operations
Management
services.

This service
monitors the
specified NTFS
folder and adds
events in the
MSMQ on the
NTFS change
event. This service
functions across all
the tenants.

Note: The SAS MOM Service Monitor monitors all the SAS Marketing
Operations Management services on all the machines on which SAS Marketing
Operations Management is installed. If any of the services stop for any reason,
this service restarts it. You can adjust the interval of the polling in the
ALServiceMonitorConfiguration.xml file. For more information about the SAS
MOM Service Monitor configuration, see “SAS Marketing Operations

Management Service Monitor Configuration” on page 66.
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Microsoft Office Processor Machine

Settings

MOMUSR is automatically created by the installer. After this user is created,
complete the following steps on the machine on which Microsoft Office
Processor is installed.

To consolidate Microsoft Word documents in an Approval job or in a Marketing
Workbench task:

1

5

6

Log on as MOMUSR and launch Microsoft Word on the web services
machine.

Select Use recommended settings, and click Accept.
On the Welcome page, click Next.

On the Sign in page, click No thanks, maybe later.
On the Meet SkyDrive page, click Next.

On the last page, click All done!.

For Adobe Acrobat:

1

2

Launch Adobe Acrobat 8.0, 9.0, or X Professional.

In the Getting Started dialog box, select Do not show at startup, and then
close the dialog box.

Log off as MOMUSR from this machine.

Configuring Security Permissions

To configure the security permissions:

1

2

On the server, select Start » Run and type Dcomenfg. exe.

Navigate to Component Services » Computers » My Computer » DCOM
Config.

For each application listed in Table 4.2 on page 37, complete the steps
from Step 4 on page 36 onwards.

Right-click on the application and select Properties.

On the Security tab, specify the following settings:

Launch and Activation Permissions: If you select the Customize
option, click Edit. Add users in the Group or user names section. Allow
Local Launch, Remote Launch, Local Activation and Remote Activation
permissions.



Configuring Security Permissions 37

Access Permissions: If you select the Customize option, click Edit. Add
users in the Group or user names section. Allow Local access and
Remote access permissions.

Configuration Permissions: If you select the Customize option, click
Edit. Add users in the Group or user names section. Allow Full Control
to the user.

Note: For the Digital Asset Management module only) If the Digital Asset
Management module supports a shared network folder, specify the DCOM
settings for MOMUSR on the Application Services, Media Services, and
Cataloger tiers.

Table 4.2 DCOMConfig

User: Network

Service,

MOMUSR Applications

Permissions Microsoft Excel Microsoft Word Microsoft
97 — 2003 PowerPoint

Launch and Customize Customize Customize

Activation

Access Use default Use default Use default

Configuration Customize Customize Customize

On the Identity tab, complete the following steps for all applications in the
DCOM configuration:

b

(o

d

Select the This User radio button.
Click Browse to select MOMUSR.

Add the user to the Group or User Names box. Provide the appropriate
password for the Password and Confirm Password fields.

Click Apply to apply the configuration, and then click OK.

If you specified DCOM settings in the previous steps but the Queue Manager
Service fails to launch the respective applications, then change the DCOM
configuration settings:

a

Go to Computer Management » System tools » Local Users and
Groups, and add the MOMUSR to the Administrators group.

Go to the DCOM Config settings, right-click the item, and select
Properties.

Click the Identity tab and select The Launching User radio button.

Click Apply and OK to save the settings.
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Configure Settings for a Digital Library
That Supports a Shared Network Folder

To set up the configuration:

1 Create a shared drive folder on any machine that is on the same network as
the installation machines.

2 Provide MOMUSR with complete access to the shared drive folder.

Note: Specify access for MOMUSR on both the Security Permissions tab
and the Sharing Permissions tab.

3 Allow Full Control to MOMUSR for the following locations:
Installation folder
Windows Temp folder
Temporary ASP.NET Files folder .NET framework
c:\Temp (Temp folder set in environment variable)

On the Network folder that is created

Note: If the installation is in the DMZ, that is, if the solution is installed on an
external machine, then add the following key in the <tenant>\web.config
directory on the external machine: <add key="CURRENTNETWORK"
value="EXTERNAL" />. When you add this key, functionality that is specific to
network folder usage is not shown on the external machine because that
machine cannot access the network folder.
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Configuring the Tenant

Create the Tenant

To create the database automatically and create the tenant:

1

Go to SQL Server Management Studio by selecting Start » Programs
Microsoft SQL Server 2008 R2 » Security » Logins.

Double-click the SAS Marketing Operations Management database user
account that you created in “Create a Database User Login Account in SQL
Server” on page 20.

Select Server Roles from the left pane.
Select the dbcreator and public server roles for the new login. Click OK.

Remove the Read-Only setting for the installation folder (which was created
on all machines during the set-up process). Grant Write access to this folder.

Create the tenant by double-clicking the TenantCreation application located
in the folder <Installation Folder>\Tenant Creation.
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Display 5.1 Tenant Creation

Tenant Name

Database Type

Database Machine Name
Database Server Instance Name
Database Name

0ODS Database Name

Database User Name

Database Password

Create Database Automatically

Use Media Server

Auditing

File System WINDOWS

Mount Point (for Files) C:\SASMOM\MountPoint
Out Box (for Files) C:\SASMOM\OUTBOX

Max File Count (for Files) 1000

XML Mount Point C:\SASMOM\XMLMountpoint

Server Installation Path C:\SASMOMY

Default Language English

Note : 1. If this is a Load Balanced Setup, please provide the UNC Path for Mount Point, Out Box and XML Mount Point paths.

or e.g: \\<Machine Name:>\..

2. Out Box for all tenants must be the same

Enter the following information:

Enter a tenant name. You can use only English alphabets (A—Z) and
Arabic numerals (0-9) for the tenant name. The tenant name cannot start
with a numeric character, cannot contain spaces, and cannot contain the
string xm1 as part of the name.

Select SQL Server as the database type. The database server instance
is populated as soon as you select the database type. Do not change it
unless required. For SQL Server, the value is Default.

Enter a database machine name or an IP address.

Enter the database name (the tenant creation utility creates the
database). The database user name and password are the credentials of
the SQL Server login created in “Create a Database User Login Account
in SQL Server” on page 20.

Keep the default value database name_ODS in the ODS Database
Name field.

Specify the installation path that you selected during installation in the
Server Installation Path field.

Keep the default value True in the Auditing field.

Specify values in the Mount Point and XML Mount Point fields. On the
web services machine, the MountPoint (for files) and the XML mount
point should be located in a folder other than the tenant folder. It can
reside within the installation folder but not under the tenant folder
because this setup creates a performance issue. Every tenant should
have an individual mount point and XML mount point.

Specify the outbox path. The virtual directory DashboardImages points to
the Outbox folder of the tenant. If you have more than one tenant in a
single-machine installation, all the tenants should point to the same
Outbox folder. If you have a multiple-machine installation, the
DashboardImages directory points to the Dashboardimages folder on
the solutions machine.
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Note: The outbox path that you specify for the tenant should be such that
the same drive can be specified on the Media Server machine.

i Inthe Max File Count field, specify the maximum number of files that can
reside within a folder under the mount point or vaults. When the file count
reaches the maximum count, a new folder is created and the subsequent
files are put under this folder.

7 If any errors are generated while the tenant is being created, view the error
details in a log file that is created in the path Installation Folder
\CreateTenant TenantName.txt. This log file is created only on the
solutions machine.

Folder Permissions

After you have created the tenant, give permissions for the following folders
using the instructions in “Grant Folder Permissions” on page 76. If these
folders are in the installation folder, then you do not need to give permissions to
them.

MountPoint
XMLMountPoint
OutBox

Create the Cataloger Mount Point

To create the cataloger mount point:

1 Enter the following URL in a browser to view the Login screen for the tenant:
http://IP Address/Tenant Name

2 Login to the SAS Marketing Operations Management using the following
credentials:

User Name: admin
Password: sa

Change the password for the admin user when prompted.

3 In the left pane under Administration, click the Settings link to navigate to
the SAS Marketing Operations Management Settings page.

4 In the Cataloger Settings section, specify the MountPoint for the primary
cataloger. Specify the mount point path as a UNC path (for example, \
\Machine name\Shared Folder Name\Cataloger Mount point). The
mount point folder should be a shared folder and should not already exist.

Specify the Secondary MountPoint if you have a secondary cataloger. The
expected input for this field is the path in the file system to which the batch
cataloger jobs will be submitted.

Note: If your Cataloger and Media Server are on the same machine, then

the mount points are created after you save these settings. If your Cataloger
and Media Server are on separate machines, you create the shared folder in
a later step. The File Watcher Service polls this folder to detect the arrival of
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batch cataloging jobs. See “Restart the Windows Services” on page 48 for
more information about restarting the windows services.

5 Save the settings.
6 If your Cataloger and the Media Server are on separate machines:

a Create a shared folder on the Cataloger machine to be your mount point.
You specified the path to this folder in the MountPoint field on the SAS
Marketing Operations Management Settings page.

b Configure MOMUSR with the same password on both the Cataloger and
Media Server machine.

7 Right-click on the shared folder that you specified as the Cataloger mount
point. On the Security Permissions tab and the Sharing Permissions tab,
grant complete access to the following users:

MOMUSR

IUSR

NETWORK SERVICE
IUSR

8 Start or restart the Cataloger and File Watcher services under the MOMUSR
account.

Configuring Additional Settings for the
Tenant

Changing the Default Session Time-out Value

You can change the session time-out value in the Tenant.xml according to the
client requirements. These changes should be done on the web server as well
as the application server. Follow the steps:

1 Open the Tenant.xml present under Installation Folder
\Configuration\XML.

2 Navigate to the SESSION node under the root node CONFIGURATION.

3 Set the DatabaseUpdatelnterval attribute value to 10% of the Timeout
attribute value. For example, if the Timeout value is 1800 then the
DatabaseUpdatelnterval value should be set as 180. Make sure this value is
a whole number and does not contain decimal values.

4 Save the Tenant.xml.

Granting Permission to the Database

The database user should have permissions to set the recovery model for the
database as Simple mode in order to minimize the accumulation of log files in
the database.
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This setting is applicable for the SAS Marketing Operations Management ODS
database, which is created by the tenant application. The following figure shows
where to make this change in Microsoft SQL Server Management Studio.

Display 5.2 Database Properties
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Grant Permissions to the Database User

In day-to-day usage, the SAS Marketing Operations Management database user
does not require a creator or owner permission. You need to grant only a limited
set of permissions to the SAS Marketing Operations Management database user
on the Tenant and the ODS database individually. The SAS Marketing
Operations Managementdatabase user login account is the user login account
that you created in “Create a Database User Login Account in SQL Server” on
page 20 and the database user corresponds to this login account.

Note: Complete the steps using the sa login account or a user account that has
permissions to create a user and role, change the user role membership and
database ownership, and grant or deny the database permission..

To grant the required permissions:

1 Ensure that no one is using SAS Marketing Operations Management. Stop
the SAS Marketing Operations Management services and IIS on all the
servers and ensure that none of the SAS Marketing Operations Management
scheduled tasks are running.

2 Go to Databases » Database » Security » Roles » Database Roles.
Right-click Database Roles and select New Database Role. Create the role
SASMOM Role, and click OK.

3 Double-click the SASMOM Role role, and then click Securables in the left
pane.

4 In the right pane, search the Tenant database. Select the following
permissions:
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Table 5.1 Permissions List
Grant List
Alter
Authenticate
Connect
Note: Do not select this access on SQL
Server 2008 R2.

Delete
Execute
Insert

Select

Update

Deny List
Alter any application role
Alter any assembly

Alter any asymmetric key

Alter any certificate

Alter any contract

Alter any database audit

Alter any database DDL trigger
Alter any database event notification
Alter any dataspace

Alter any fulltext catalog

Alter any message type

Alter any remote service binding
Alter any role

Alter any route

Alter any service

Alter any symmetric key

Alter any user

Backup database

Backup log

Checkpoint

Create aggregate

Create assembly

Create asymmetric key

Create certificate
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Grant List Deny List
Create contract
Create database ddl event notification
Create default
Create fulltext catalog
Create function
Create message type
Create queue
Create remote service binding
Create role
Create route
Create rule
Create schema
Create service
Create symmetric key
Create type
Create view
Subscribe query notifications

Take ownership

5 Search the ODS database, and set the same permissions as for the Tenant
database.

6 If you have created the database automatically, the SAS Marketing
Operations Management database user belongs to the db_owner role. You
need to remove the user from the db_owner role. Verify whether the SAS
Marketing Operations Management database user is listed under Databases

Database » Security » Users.

If the SAS Marketing Operations Management database user is not listed,
then verify whether the dbo login user account corresponds to the SAS
Marketing Operations Management database user account. Double-click
on the dbo user and verify whether the login name is the same as the
SAS Marketing Operations Management database user login account. If
they are the same, then set the database owner to the sa account by
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7

right-clicking the database, select Properties, and then click the Files link
in the left pane.

If the SAS Marketing Operations Management database user is listed,
then double-click on the SAS Marketing Operations Management
database user. Remove the user from the db_owner role by clearing the
check box (in the Database role membership section), and then click
OK.

If the SAS Marketing Operations Management database user is not listed
under Databases » Database » Security » Users, then create a SAS
Marketing Operations Management database user corresponding to the user
login account that you created for the database server. Right-click Users and
select New User. Provide the SAS Marketing Operations Management
database user name for the User name and select the SAS Marketing
Operations Management database user login account for the login name.

Go to Databases » Database » Security » Users. Double-click on the
user name, and select the SASMOM Role role under the Database role
membership section in the right pane.

If the user is a member of the dbcreator role, remove the SAS Marketing
Operations Managementdatabase user login account from that role. To do so
go to Server » Security » Logins, double-click on the user name, and click
the Server Roles link in the left pane.

Note:

Disable HTTP

Before you create a new tenant, add the SAS Marketing Operations
Management database user login account back in the dbcreator role.

Similarly before you perform a migration or update of SAS Marketing
Operations Management, you must add the SAS Marketing Operations
Management database user back into the dbowner role, and remove it from
<SASMOM Role> role.

If you selected the HTTPS protocol while you were installing SAS Marketing
Operations Management, you must disable HTTP.

To disable HTTP:

1

Select Start » Run and type IIS Manager.

2 Click the Default Web Site node in the tree view in the left pane.

3 Double-click the SSL Settings icon.
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4 Select the Require SSL check box.

5 Select the Ignore radio button for the Client certificates.

If you are using Artwork Producer, then you need to create the following FTP

sites:

Table 5.2 FTP Sites

FTP Site Name

ExportedFormats or
<TenantName>_ExportedF
ormats

DownloadedFormats or
<TenantName>_Download
edFormats

<Any Name>

Folder Path

Installation Folder
\ TenantName\Exported
Formats

Installation Folder
\ TenantName
\Downloaded Formats

Installation Folder
\TenantName\Import
Formats

Description

Formats exported from the
system are copied into this
folder. You can use this
FTP site to download the
exported format.

Formats downloaded from
the system are copied into
this folder.You can use this
FTP site to download the
format.

The system uses this
folder to pick up formats to
be exported out of the
system. You can upload
exported formats (to be
imported into the system)
to the folder by using this
FTP site.
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After you create these FTP sites, you must modify the <TenantName>.xml file
that is located in <InstallationDir>\Configuration\XML on the solutions
machine. Make the following changes in this file:

1 Go to the ARTWORKPRODUCER\EXPORTFORMAT\FTPNAME node and
modify the FTP name to be the name that was supplied when
ExportedFormats was created.

2 Go to the ARTWORKPRODUCER\DOWNLOADFORMAT\FTPNAME node
and modify the FTP name to be the name that was supplied when
ExportedFormats was created

Restart the Windows Services

After you create the Cataloger Mount Point, restart the following Windows
services:

SAS MOM Back-Office Service

SAS MOM Cataloger Service

SAS MOM DAM Job Copy Service (only if this service is installed)
SAS MOM Dashboard Service

SAS MOM File Watcher Service

SAS MOM Format Watcher

SAS MOM Notification Service

SAS MOM PluginService Service

SAS MOM Queue Manager Service

SAS MOM Replication Agent Service (only if this service is installed)
SAS MOM Report Scheduler

SAS MOM Service Monitor

SAS MOM Text Cataloger Service

SAS MOM NTFS Monitoring Service

Refer to “Running a Service under the MOMUSR Context” on page 78 for
more information.

Verify Scheduled Tasks
The following scheduled tasks are created automatically:
AL_DAMBackGroundRequestHandler
ALCleanUp utility
DAMVaultUserAccessUpdate
MOMDiagnosticUtilityRptGenerator
SecurityPolicyUpdate

If these tasks are not scheduled, determine whether the scheduled tasks have
been created. Refer to “Configuring Scheduled Tasks” on page 99 for more
information.
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Changing the MOMUSR Password

Change the MOMUSR Password on the Servers

The MOMUSR is created at the time of installation. Depending on the password

policies at your organization, you need to change the password periodically. If
the MOMUSR is selected as a local system user, then you must complete the

following steps.
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Note: The password for MOMUSR should be the same on all servers in your
configuration.

To change the password on all the servers in your configuration:

1

2

3

Select Start » Control Panel. Click Administrative Tools.

In the tree view, expand Local Users and Groups under Computer
Management.

Right-click MOMUSR and select Set Password.

Display 6.1 Computer Management Window
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Enter the new password, and click OK.

Change the Password on Windows Services

You must modify the Windows services related to SAS Marketing Operations
Management, which run on the MOMUSR account.

Complete the following steps for each SAS Marketing Operations Management
service that is in your configuration:

Note: You must complete these steps on all the servers that are in your
configuration.

1

2

3
4

a

(-]

Open the Services applet.

Right-click on a service, and select Properties.

Click the Log On tab. MOMUSR is the default account.
Modify the password.

Click Apply to apply the settings. Click OK.

Restart the service.
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Change the MOMUSR Password in the DCOM
Configuration

You need to change the DCOM configuration for Microsoft Office applications,
depending on which of the following applications are installed in your
environment:

Microsoft Excel
Microsoft Office Word
Microsoft Office PowerPoint
To change the password for MOMUSR in the DCOM configuration:

1 Select Start » Run, and then open DCOMCnfg.

2 Select Component Services » Computers » My Computer » DCOM
Config.

w

Right-click on the application and select Properties. On the Identity tab,
change the settings. MOMUSR is selected.

H

Modify the password.

a

Click Apply to apply the settings.

(-]

Click OK to save and close the configuration.

Change the MOMUSR Password for Application
Pools

Complete the following steps to change the MOMUSR password for
SASMOMAppPool.

Note: You need to follow the steps on solutions, web services, cataloger, media
server, and Microsoft Office processor servers.

To change the MOMUSR password for the SASMOMAppPool:

1 Open Internet Information Services (11S) Manager from the Start menu.
Navigate to the path <Server Name>\Application Pools.

2 Click the Advanced Settings option for SASMOMAppPool.

3 Expand the Process Model section. Click the ellipsis button in the Identity
row.

4 Click Custom account, and then click Set.

5 Modify the password and click OK.

Verify the System

After you complete all the changes for the MOMUSR password, complete the
following tasks:

Verify that the Windows services are started on all the servers.
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Verify that a login to the SAS Marketing Operations Management system via
a browser is successful.

Test the specific modules.

Configuring the Media Server Proxy

SAS Marketing Operations Management uses the Media Server component to
share the load of the IIS for downloading data from the system. When you are
downloading files, SAS Marketing Operations Management directly accesses
the Media Server. If you have a DMZ setup and the media server is installed on
an internal server, then SAS Marketing Operations Management cannot access
the Media server directly. To handle this situation, use the following workaround:

When you are installing solutions in DMZ, select Media Server along with the
other components. This Media Server will be treated as a proxy of the internal
Media Server. You must change the following configuration after the installation.

Tenant Web.config on the external solution machine:
<add key="DeploymentMode” value= “MULTI” />

<add key=“ALMEDIASERVERFILEDOWNLOADURL”
value="http://<External solution machineIP>/ALMediaServices/Aspx/FileDownload.aspx” />

Media services web.config onthe external solution machine. Add the following
keys:

<add key="ALMEDIASERVERMTOMWS”

value="http://<Media ServerIP>/ALMediaServices/ALMTOMWS.asmx” />

<add key="ISMEDIASERVERPROXYINSTALLED” value="“true”/>

<add key="“UploadAssemblyName”
value="<Installation Dir>\SAS MOM\<Tenant Folder>\Bin\ALCommonExtension.dll” />

Dashboard service exe configuration on the internal server, InstallationMode =
MULTI.

After you complete these changes, the external solution will be able to download
the original and preview files from the system and display the digital asset
channels on the external server.

Configuring the Replication Agent

The following sections provide the guidelines for installing the Replication Agent,
which is used to replicate files across machines. You must complete the
following configurations before you start the agent.

Configure the Replication Agent

The Replication Agent is always installed on the Solutions (web server)
machine. The Replication Configuration XML file is present in <Installation
Directory>\Configuration\ReplicationAgentConfig.xml.



Note: Replication does not replicate sites ac
replicate sites that are created in the system
setup onto other machines. Sites that are cre
be copied manually on the external machine.
internal also. Whenever any changes are ma
the replication process.

To configure the Replication Agent:
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ross machines. You must manually
through an internal or external
ated on the internal setup have to
This holds true for external to

de to a site, you should complete

1 Replace SALSINSTALLDIRSALS with installation directory path. For example,
replace $ALSINSTALLDIRSALS with D: \SASMOM60 R14.

Note: Do not include a backslash at the end of the path.

2 Replace $ALSTENANTNAMESALS$ with the name of the created tenant. For

example, replace SALSTENANTNAMESA

L$ with ASO.

3 FILESTOPRESERVE: This has to be configured only when certain attributes

from the file need to be retained after repl

ication.

Note: If attributes do not need to be retained after replication, remove the

FILESTOPRESERVE node.

The following folders and files are monitored

Table 6.1 Folders and Files Monitored by the Replication Agent Service

Folder

by the Replication Agent Service:

File

$ALSINSTALLDIRSALS\ $ALSTENANTNAMESALS\DAM\Configuration\XML *.xml
g

$ALSINSTALLDIRSALS\ $ALSTENANTNAMESALS\DAM\Configuration\XML *.xml
g

\FormBuilder

$AL$INSTALLDIR$AL$\$AL$TENANTNAME$AL$\MediaLibrary
\Configuration\XML

$ALSINSTALLDIRS$ALS\SALSTENANTNAMESALS \MediaLibrary
\Configuration\XML \FormBuilder

$AL$INSTALLDIR$AL$\$AL$TENANTNAME$AL$\StrategicPlanner
\Configuration\XML

$ALSINSTALLDIRSALS\SALSTENANTNAMESALS\StrategicPlanner
\Configuration\XML \FormBuilder

$AL$INSTALLDIR$AL$\$AL$TENANTNAME$AL$\MarketingWorkbench
\Configuration\XML

$ALSINSTALLDIRSALS\SALSTENANTNAMESALS \MarketingWorkbench
\Configuration\XML

$AL$INSTALLDIR$AL$\$AL$TENANTNAME$AL$\MarketingWorkbench
\Configuration\XML \FormBuilder

SALSINSTALLDIRSALS\SALSTENANTNAMESALS \Approvals
\Configuration\XML\

* xml

xml

xml

xml

SolutionConfiguration.xml

* DataTransferConfig.xml

xml

* . xml
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Folder

SALSINSTALLDIRSALS\SALSTENANTNAMESALS \Approvals
\Configuration\XML\FormBuilder

SALSINSTALLDIRSALS\SALSTENANTNAMESALS\Administration
\Configuration\XML

SALSINSTALLDIRSALS\SALSTENANTNAMESALS \Administration
\Configuration\XML\FormBuilder

$AL$INSTALLDIR$AL$\$AL$TENANTNAME$AL$\ResourceManagement
\Configuration\XML

$ALSINSTALLDIRS$ALS\SALSTENANTNAMESALS \ResourceManagement
\Configuration\XML\FormBuilder

Configure the Replication Server

File

xml

xml

xml

xml

* . xml

The Replication Server is always installed on the SAS Marketing Operations
Management Services machine.

On that machine, configure the ReplicationServerConfig.xml file that is located in
the <Installation Directory>\Configuration\XML folder. You must
change the following configuration to indicate the agents that are present and
the details about that agent.

=COMNFIGURATION=
=AGENMTLIST=
=INTERMALAGENT =
=EXTERMALAGEMT /=
=fAGEMTLIST=
=ICONFIGURATION=

After you change the configuration, the XML file contains information similar to
the following:

<CONFIGURATION>

<AGENTLIST>

<INTERNALAGENT >

<AGENT IP="198.113.120.127" >c:\SAS MOM 60</AGENT>
</ INTERNALAGENT>

<EXTERNALAGENT >

<AGENT IP="198.113.120.172">E:\SAS MOM 60</AGENT>
</EXTERNALAGENT >

</AGENTLIST>

</CONFIGURATION>

If the communication protocol for internal agents is always TcPp, then the
communication protocol for external agents is http:// by default.

Routing Media Requests

This setting is required only if you are using an external machine (not in
network).
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Open the file in <Installation Directory>\Configuration\XML
\MediaRequestRouter.xml. You need to change the node that is specific to
ReplicationServer in MEDIAPROCESSAQ to point to the internal machine
ReplicationServerQ. Change the highlighted portion to the following:

FormatName:DIRECT=http://<Internal machine IP address>
/msmg/Private$/ReplicationServerQ

After you make the changes, the XML file contains information that is similar to
the following:

<MEDIAPROCESSOR SOLUTIONNAME="ReplicationManager”>
<ROUTEMESSAGETIMEOUT>720</ROUTEMESSAGETIMEOUT >

<APPLICATION TYPE="ReplicationServer”>
<MEDIAPROCESSORQPATH>FormatName : DIRECT=
http://198.113.120.127/msmg/Private$/ReplicationServerQ</MEDIAPROCESSORQPATH>
<FILEPATH>

<REPLACEABLEPATH>D:\SAS MOM\Replication</REPLACEABLEPATH>

<NETWORKPATH/ >

</FILEPATH>

</APPLICATION>

<APPLICATION TYPE="ReplicationAgent”s>

<MEDIAPROCESSORQPATH>FormatName :
DIRECT=TCP:198.113.120.172\Private$\ReplicationAgentQ</MEDIAPROCESSORQPATH>
<FILEPATH>

<REPLACEABLEPATH>D:\SAS MOM\Replication</REPLACEABLEPATH>

<NETWORKPATH/ >

</FILEPATH>

</APPLICATION>

</MEDIAPROCESSOR>

Installing Replication Agent Services

After you have completed the configuration, start the services. To install the
Replication Agent, run the InstallReplicationAgentServices.bat file from the
<Installation Directory>\Binaries folder. The service is installed and is
displayed in the Services Panel.

Replication also requires the SAS MOM Queue Manager Service to be running.
Start both the services from Service Panel.

Note: To uninstall the replication service, run the
UninstallReplicationAgentServices.bat file from <Installation Directory>
\Binaries. The SAS MOM Replication Agent Service is removed from the
Service Panel.

Fine-Tuning Tips

Running Services Selectively

When SAS Marketing Operations Management is installed, several Windows
services are also installed. These services run in the background to facilitate
certain functionality that is provided by different solutions. As these processes
run in the background, they consume resources in terms of database access
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and memory. You can selectively start these services, depending on whether the
service is required.

Table 6.2 Services and Dependencies

Service Name
SAS MOM Back-Office Service

SAS MOM BusinessEvents
Service

SAS MOM Cataloger Service

SAS MOM DAM Job Copy
Service

SAS MOM Dashboard Service

SAS MOM File Watcher Service

SAS MOM Format Watcher
SAS MOM Notification Service

SAS MOM NTFS Monitoring
Service

SAS MOM PluginService Service

SAS MOM Queue Manager
Service

SAS MOM Replication Agent
Service

SAS MOM Report Scheduler

SAS MOM Service Monitor

SAS MOM Text Cataloger
Service

Modules that Require this Service
Marketing Workbench, Strategic Planner, and so on.

Strategic Planner (for Marketing Workbench, Claims Management, Offer
Management, and all other modules that track change management —
Audit History on forms)

Digital Asset Manager (can also be used by other modules such as
Artwork Producer if cataloging is used)

Digital Asset Manager

Dashboard and Calendars

Digital Asset Management (can also be used by other modules such as
Artwork Producer if cataloging is used)

Artwork Producer
All modules

Currently not used by any module but can be configured to track any
events on the NTFS.

Marketing Workbench, Approvals, Strategic Planner

Marketing Workbench, Approvals, Reports, Timesheets, Strategic
Planner, Digital Asset Manager

All modules

Reports

All modules (this service monitors all the services that are used by various
modules)

Digital Asset Manager(text search)

Improving the Performance of the Digital Asset

Manager Module

Here are the keys and their values that need to be added in the Web.config file
located at Installation Folder\Tenant Name\ on the server on which the
modules are installed.

Example values:
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<add key="MULTIDOMAINSUPPORT” value="true” />

<add key="MAXDOMAINCOUNT” value="5" />

<add key="PREFIXDOMAINNAME” value="Sun” />

<add key="SUFFIXDOMAINNAME” value="india.sas.com” />

Multi-domain support improves performance while fetching the thumbnails in
Digital Asset Manager. The browser serializes the request to download a
particular file. If 100 assets are to be shown on the screen, then more time is
required to download the files. You can download only two files at a time. If
multiple domains are configured, then these requests are divided into the
number of domains, which improves performance.

Note: Configure the domain before you set the multi-domain key to True.

Improving the Performance of SAS Marketing
Operations Management

SQL Services

In order to improve the performance of SAS Marketing Operations Management,
start only the SQL services that the following table indicates should be started.

Table 6.3 SQL Services

Automatic, Manual, or

SQL Service Started or Not Started Disabled
SQL Server Started Automatic
(MSSQLSERVER)

SQL Server Active Not Started Disabled

Directory Helper

SQL Server Agent Started Automatic
(MSSQLSERVER)

SQL Server Analysis Not Started Manual
Services

(MSSQLSERVER)

SQL Server Browser Not Started Disabled
SQL Server FullText Started Automatic

Search (MSSQLSERVER)

SQL Server Integration Not Started Manual
Services

SQL Server Reporting Off Manual
Services

(MSSQLSERVER)

SQL Server VSS Writer Off Manual
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Cache Management

Cache management is implemented in SAS Marketing Operations
Managementfor quick retrieval of data rather than searching for information in
the database every time. Information such as Entity Type, Facet Type, and
Relationship Type are stored in memory. Information such as Named
Hierarchies is stored in the file system.

Application Service Cache: The Application Service caches the metadata
such as Entity Type, Facet Type, and Relationship Type as an in-memory
cache. This type of cache reduces queries to the database. The cache is
configurable, and you can turn it on by using the following key in the
Web.config file of the ALServices virtual directory: <add
key="OMCacheEnabled" value="true"/>. The value true indicates that
the cache is enabled.

Note: The cache is refreshed if the metadata is modified from the Schema
Designer. If the metadata is modified from somewhere else, then restart the
web server on the web services server machine.

Named Hierarchy Cache: SAS Marketing Operations Management caches
the Named Hierarchy information as a persistent data on the file system. This
improves performance because data is fetched from the cache instead of by
web service calls. The cache is stored at the following location:
Installation Folder\Temp\Tenant Name Cache

All the named hierarchies are stored as an XML file.

You can configure the cache and turn it on by using the following key in the
Web.config file of the <TenantName> virtual directory on the SAS Marketing
Operations Management Solutions machine: <add
key="PersistentCacheEnabled" value="true"/>. The value true
indicates that the cache is enabled.

Note: If possible, keep this folder out of the cleanup process. The cache is
refreshed if the named hierarchy is changed from the Schema Designer. If
the named hierarchy is modified from somewhere else, then you must delete
the XML files from the persistent cache.

Tuning the Database

To tune the database for better performance:
1 Ensure that there are no active connections to the database:

a Stop all SAS Marketing Operations Management Services on all the
servers in the installation.

b Reset IIS on the web services server.

¢ Run the following script using SQL Server Management Studio. Do not
run this script on the ODS database.

DECLARE @SPID NVARCHAR (5),@CURRENT SPID SMALLINT,@DBNAME NVARCHAR (75)
SELECT @CURRENT SPID = @@SPID
SELECT @DBNAME = DB NAME ()

DECLARE C1 CURSOR FOR
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SELECT SP.SPID

FROM

SYS.SYSPROCESSES SP INNER JOIN SYS.DATABASES DB

ON SP.DBID = DB.DATABASE ID AND DB.NAME = @DBNAME AND SP.SPID <>
(SELECT @@SPID)

OPEN C1
FETCH NEXT FROM Cl INTO @SPID
WHILE @@FETCH STATUS = 0

BEGIN
EXEC ('KILL '+@SPID)
FETCH NEXT FROM Cl INTO @SPID
END
CLOSE C1

DEALLOCATE C1

EXEC (N'ALTER DATABASE '+@DBNAME+' SET READ COMMITTED SNAPSHOT ON ')
GO

Note: Ideally, this script should not take more than 10 seconds to run. If
you do not complete all the previous steps in this process, the script runs
in an infinite loop. The user running this script must have Alter permission
to the database.

d Start all SAS Marketing Operations Management Services.

2 Manually truncate the Tenant Database log files and the Operational Data
Store (ODS) transaction log files. These logs increase in size over long
periods of system usage. You need to truncate the logs manually at regular
intervals with the help of a database administrator to ensure that the disk
space is optimally used.

3 Temp DB optimization recommendations:

Number of data files: Create one data file per CPU. A dual-core CPU is
considered to be two CPUs. Click Files and enter the following
information:

Initial Size: 100 Mb
Autogrowth (File growth): By 10 %, Unrestricted growth

Path (Location): You should add the Tempdb database on disks that
differ from those that are used by user databases.

Note: For more information about these recommendations, see http://
msdn.microsoft.com/en-in/library/ms175527%28v=sql.105%29.aspx.

1S Performance Tuning

Minimize Logging

Microsoft recommends IIS logging to be minimized or even disabled completely
on the production servers to improve IIS performance.


http://msdn.microsoft.com/en-in/library/ms175527%28v=sql.105%29.aspx
http://msdn.microsoft.com/en-in/library/ms175527%28v=sql.105%29.aspx
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For more information about how to disable 1IS logging, see the information about
logging at http://msdn.microsoft.com/en-us/library/ee377050%28BTS.
10%29.aspx.

Application Pool Settings

SAS Marketing Operations Management is based on Microsoft .NET technology.
It uses various Microsoft technologies in its own solution. It is assumed that SAS
Marketing Operations Management is installed on a Windows 2008 Server and
that 1IS 7.0 is the base platform. For optimal performance of SAS Marketing
Operations Management, the following configuration is required on Internet
Information Services (l1S).

ASP.NET is disabled by default in 1IS 7.0. If you do not enable ASP.NET, an
error might be generated.

To enable ASP.NET:

1 Open Internet Information Services Manager.

2 Click ISAPI and CGI Restrictions.

3 Right-click ASP.NET v4.0.30319 and select Allow.

To configure the SASMOMAppPool application pool (or any other application
pool) using the recommended settings:

1 Disable the Recycle Worker Process setting. This setting restarts the
ASP.NET worker process after 1740 minutes (that is, 29 hours). To disable
this setting:

a Open the Internet Information Services Manager.
b GotoApplication Pools / SASMOMAppPool / properties.

c Click the Recycling tab and clear the Recycle Worker Processes check
box.

2 Disable the Idle Timeout Shutdown Worker Process setting. This setting
shuts down the ASP.NET worker process if the worker process is idle for 20
minutes. To disable this setting:

a Open the Internet Information Services Manager.
b GotoApplication Pools /SASMOMAppPool/ properties.

c Click the Performance tab and clear the Shutdown worker processes
after being idle for check box.

Configure SAS Marketing Operations
Management for Full Text Searching

The default logical operator that is used for a simple search based on multiple
words is AND. You can configure the default logical operator.


http://msdn.microsoft.com/en-us/library/ee377050%28BTS.10%29.aspx
http://msdn.microsoft.com/en-us/library/ee377050%28BTS.10%29.aspx
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To change the logical operator to OR:

1 Open the TenantName.xml file from Installation Folder
\Configuration\XML.

2 Look for the following XML node.

<FULLTEXTSEARCH>
<LOGICALOPERATOR>AND</LOGICALOPERATOR>
</FULLTEXTSEARCH>

3 Change the AND to OR.

<FULLTEXTSEARCH>
<LOGICALOPERATOR>OR</LOGICALOPERATOR>
</FULLTEXTSEARCH>

Suppress Dialog Boxes for Automatic
Updates

To disable the automatic updates in Adobe Acrobat X and XI:

1 Select Help » Check for Updates. The Preferences link appears after
updates are checked.

2 Click the Preferences link. The Automatically check for updates check
box is displayed.

3 Clear the Automatically check for updates check box, and click OK.

SAS Marketing Operations Management
Diagnostic Utility

Beginning with SAS Marketing Operations Management 6.0 R14 Update 2, no
files in the file system are physically deleted from the system. This prevents files
from being accidentally deleted or lost. When a file is updated or overwritten,
either in the user interface or by the system, a Marked for deletion flagis
appended to the file. Since the files are not explicitly deleted, these files are
present in the file system. These files must be cleaned up by a services person
or by an administrative user with sufficient product knowledge.

Use the following utilities to clean the system:

1 MOMDiagnosticUtilityRptGenerator: The EXE file for the utility is available at
Installation Folder\Binaries. This utility generates an XML report
containing a list of files that are marked for deletion and that need to be
removed from the server. This utility is executed by a scheduled task
(MOMDiagnosticUtilityRptGenerator task) that is created on the application
server after installation. This scheduled task runs at 12 a.m. every night and
generates one report per tenant. The report is generated at Installation
Directory\Logs\MOMDiagnosticUtility on the application server.
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Read the report in the following manner:

The utility creates multiple reports in an XML format in batches of 10,000
file entries. For example, if a total of 100,000 entries are found for
MARKEDASDELETED, ORPHAN, or MISSING files, then the utility
generates 10 reports of 10,000 entries each.

The report naming convention is MDURG_<Tenant Name> <Date
Time> <Sequence Number>.xml. The sequence number begins at 0. In
the previous example, the reports are created from 0 to 9.

The last file contains the summary information about the space consumed
and the file count.The following table describes the summary information:

Table 6.4 Summary Information Generated by the
MOMDiagnosticUtilityRptGenerator Utility

Node in Log File

APP_SERVER_FILES

MEDIA_SERVER_FILES

MARKASDELETEDFILES

MARKASDELETEDFILES (with

MISSING attribute set to 1)

ORPHANFILES

SPACE_CONSUMED

FILE_COUNTS

Description

List of files on the application server that
are to be cleaned up.

List of files on the media server that are
to be cleaned up.

List of files on all servers that are
marked for deletion.

List of files that are missing. An entry for
the file is in the ALFS_FILE table but
there is no corresponding physical file
on the NTFS.

List of files that are orphaned. A
physical file was found on the NTFS but
there is no entry in the ALFS_FILE
table.

Space consumed (in bytes) by the files
marked for deletion on every server.
Space is calculated per drive. A
combined total of space consumed on
all drives is also provided.

Count of the files to be cleaned up on
every server.

2 MOMDiagnosticUtilityRptProcessor: Run this utility manually. This utility uses
the reports generated by the MOMDiagnosticUtilityRptGenerator utility. It
cleans the files in the file system and the database entries. It is located in the
Installation Folder\Binaries folder directory. This utility performs
the cleanup per tenant, and then it generates the log files per tenant.

Read the report in the following manner:

The utility creates multiple reports in an XML format that correspond to
the reports generated by the MOMDiagnosticUtilityRptGenerator utility.
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The report naming convention is MDURP_<Tenant Name> <Date
Time> <Sequence Number>.xml. The sequence number begins at 0. In
the previous example, the reports are created from 0 to 9.

The last file contains the summary information about the space recovered
and the file count. The following table describes the summary information:

Table 6.5 Summary Information Generated by the
MOMDiagnosticUtilityRptProcessor Utility

Node in Log File

APP_SERVER_CLEANUP

MEDIA_SERVER_CLEANUP

MARKASDELETEDFILES

MARKASDELETEDFILES (with
MISSING attribute set to 1)

ORPHANFILES

SPACE_RECOVERED

FILE_COUNTS

FILE_COUNTS_PROCESSED

Note:

Description

List of files on the application server that
were cleaned up.

List of files on the media server that
were cleaned up.

List of files on all servers that were
marked for deletion and were cleaned

up.

List of files that were noted as missing
on a server and were cleaned up.

List of files that were orphaned on a
server and were cleaned up.

Space recovered (in bytes) by the files
that were cleaned up on every server.
Space is calculated per drive. A
combined total of space recovered on
all drives is also provided.

The count of the files that were
submitted to the utility for cleanup, per
server.

The log count of the files that were
successfully processed or that failed
while the utility was running.

Remember to back up the file mount point, vaults, and database before
you execute the MOMDiagnosticUtilityRptProcessor utility.

You do not need to run this utility daily.

Run this utility when the system is minimally used or outside of business

hours.
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Configure SAS Marketing Operations
Management Cleanup Utility

The ALCleanup utility is used to periodically clean the temporary folders and
files that are used by the SAS Marketing Operations Management system. A
copy of this utility is on all the machines in the installation except for the Media
Processor. You need to schedule this utility to run on each of the machines in
the setup. It works on a configuration XML that specifies the folder and files to
be deleted and the folders to exclude during cleanup.

The configuration XML is located at Installation Folder\Configuration
\XML\ALCleanup.xml.

The TempFolder node specifies the folder contents that need to be deleted. The
attribute Location of TempFolder specifies the path of the folder. For
example, ¢:\Temp is the folder whose contents will be deleted.

The DeleteOlderThan attribute specifies how old the files are that you want to
delete. The value 2 specifies that files older than 2 days need to be deleted.

The FileExtList attribute specifies the type of files that you want to delete.
You can specify the extension list, separated by a semicolon (;) if you want to
delete only specific type of files. If you want to delete all the files, specify *.*.

You can specify to delete multiple folders by using the TempFolder node multiple
times. You can also specify folders inside the ¢: \Temp that you do not want to
delete by adding AVOIDFOLDERLIST inside the TempFolder node.

<TempFolder Location="C:\Temp" DeleteOlderThan="2" FileExtList="*.jpg;

@.bmp" Comments=""></TempFolder><TempFolder Location="C:\SASMOM\Temp"

DeleteOlderThan ="2" fileExtList="*.*" Comments=""><AVOIDFOLDERLIST><AVOIDFOLDERLIST>
C; \SASMOM\Temp\FileConverter</AVOIDFOLDER><AVOIDFOLDERLIST></TempFolder>

The above code specifies not to delete the FileConverter folder or its contents,
which is inside C:\Installation Directory\Temp. You can add multiple
AVOIDFOLDER nodes in order to specify multiple folders (under the parent
path) that should not be deleted.

The following folders need to be cleaned on all the machines:

Table 6.6 Folders to Delete on All Machines

Folder
Folder location to be
File Extension Delete Older Deletion Folder avoided for
Location List Than Frequency Deletion Day deletion
Installation @ *.* 2 DAILY 1 <Installatio
Folder\Temp n Directory>
\Temp
\<TenantName

> Cache



Location

Installation
Folder
\Tenant Name
\DownloadFil
es

Installation
Folder
\Tenant Name
\UploadedFil
es

C:\Temp
Outbox Path

Installation
Folder
\MediaProces
sor

C:\Temp
\Plugins

Installation
Folder
\MediaProces
sor
\ArtworkCach
e

<Installatio
n Folder
\Errors

Installation
Folder\Logs

Installation
Folder
\<TenantName
>\Logs

File Extension
List

* %

Configure SAS Marketing Operations Management Cleanup Utility 65

Delete Older
Than

12

As per the
setting in the
Digital Library

365

180

180

180

Folder
Deletion
Frequency

WEEKLY

WEEKLY

DAILY
DAILY

DAILY

DAILY

DAILY

DAILY

DAILY

WEEKLY

Folder
Deletion Day

1

Folder
location to be
avoided for
deletion

<Installatio
n Directory>
\MediaProces
sor
\ArtworkCach
e and
<Installatio
n Directory>
\MediaProces
sor
\FormatCache
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SAS Marketing Operations Management
Service Monitor Configuration

The SAS Marketing Operations Management services are installed on all the
machines on which the software is installed. Depending on which components
are installed, the services are installed. If you do not want to watch a specific
service, then remove its respective node from the list and restart the monitoring
service. The XML file for the SAS MOM Service Monitor service is in
Installation Folder\Configuration\XML
\ALServiceMonitorConfiguration.xml.
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Uninstalling SAS Marketing
Operations Management

Uninstall SAS Marketing Operations Management 67

Uninstall SAS Marketing Operations

Management

To uninstall a SAS Marketing Operations Management setup:

1 Select Start » Control Panel » Programs and Features. Select SAS MOM
version_numberrelease_number. Right-click and select Uninstall.

2 Restart the server after the process is completed.

3 After restarting the server, clean up the following items:

If there are shared folders within the installation folder, unshare the folder,
and then delete the installation folder.

Delete any folders that were created for the SAS Marketing Operations
Management installation outside the installation folder, such as
FileMountPoint, XmIMountPoint or DAM Vault folders.

Delete the registry values that are located at
HKEY LOCAL_ MACHINE>>SOFTWARE>>Assetlink within the registry.

Within the IS Manager, delete all virtual directories that were created for
SAS Marketing Operations Management. These directories are found
under <Machine Name>\Sites\Default Web Site and include
directories such as ADCataloger, ALIntegrationServices,
ALMediaServices, ALServices, Dashboardimages, SASMOMJS, and all
directories that point to the tenant folders. To identify virtual directories
that point to a tenant, look for the virtual directory that has the same name
as the tenant, or check for the Physical Path attribute.

Under the IIS Manager remove SASMOMAppPool, within the Application
Pools section.

In the Computer Management section, look for local user MOMUSR and
delete it.



68 Chapter 7 / Uninstalling SAS Marketing Operations Management

g If the SAS Deployment Wizard entry for the installation is not removed
when you complete the uninstallation process, complete the following
steps:

a Open the deploymntreg folder, which is below the SASHOME folder.
Open the file registry.xml.

b Remove the mominstall key and all the keys directly below it. Save the
file.

4 On the database machine, delete all databases that point to the tenants.
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User Creation Fails-Configure Windows
User on the Server

Note: If MOMUSR already exists on the machine, then the password is reset to
what the user entered while installing SAS Marketing Operations Management.

Create MOMUSR on all the machines on which SAS Marketing Operations
Management is installed and on the machine on which the shared network folder
is created (for supporting a shared network folder). MOMUSR should belong to
the Administrators group.

To create the MOMUSR:

1 Go to Start » Administrative Tool » Server Manager » Configuration
Local Users and Groups » Users.

N

Right-click Users and select New User from the speed menu.

Enter all the necessary values such as name (MOMUSR) and password.

A @

Select User cannot change password.

a

Select Password never expires.

(-]

Click Create.
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Note: Make sure that the user name and password is the same on all the
machines in the configuration.

Configure Environment Variables—Failed

If the installer fails to configure the environment variables, then follow the steps
given below.

Configure Environment Variables for All Machines

The same settings need to be specified on all the machines that are involved in
the setup.

Right-click the Computer icon, click Properties, and then click Advanced
System Settings. Click the Advanced tab. Click Environment Variables. Set
the system environment variables TEMP and TMP to point to folder ¢: \Temp.
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Create the folder ¢: \Temp if it does not exist. Allow Everyone and MOMUSR
full control on this folder.

Display 8.2 System Properties
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Display 8.3 Environment Variables
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Note: Do not edit the TEMP and TMP variables.

Virtual Folder aspnet_client Creation Failed

Create a virtual folder named aspnet_client. Point to the aspnet_client folder
under www root (for example, ¢: \Inetpub\wwwroot\aspnet client).

No Security Permissions Exist

If the security permissions are not provided during the installation process,
complete the tasks in the following sections.

On ASP.NET Temporary Files

The folder ¢: \Windows\Microsoft .NET
\Framework64\v4.0.30319\Temporary ASP.NET Files should have Full
Control to the Users groups (right-click on this folder and open the Security
tabs).
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Registry Access

For MOMUSR: This setting needs to be specified on all the machines on which
SAS Marketing Operations Management is installed.

To give registry access to the newly created user (MOMUSR):
1 Open the registry by entering regedit in the Run window.

2 Navigate to the path HKEY LOCAL MACHINE\SYSTEM
\ControlSet001l\Services\Eventlog.

3 Right-click and click on the permissions. Add the newly created user
(MOMUSR) and give the user full control.

For NETWORK SERVICE users: This setting needs to be specified on all the
machines on which SAS Marketing Operations Management is installed.

To give registry access to network services users:
1 Open the registry by entering regedit in the Run window.

2 Navigate to the path HKEY LOCAL MACHINE\SYSTEM
\ControlSet001l\Services\Eventlog.

3 Right-click and click on the permissions. Add the network services users and
give them full control.

Grant Folder Permissions

Allow the IUSR, NETWORK SERVICE, and MOMUSR user accounts full control
to the Installation Path folder on all the machines on which SAS Marketing
Operations Management is installed.

In Windows Explorer:

1 Right-click on the installation folder and select Properties.
2 Click the Security tab.

3 Select the user and give Full control.

For example, if the server on which the solution is installed is called Metis, the
accounts IUSR and NETWORK SERVICE users should be granted full control to
the Installation Path folder.

Note: Give full control to MOMUSR on all the machines where the MOMUSR
has been created.
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Adding a DLL in the Global Assembly
Cache

In a multi-machine installation, both the DLLs (FluorineFx.dll and itextsharp.dll)
are not required for every component, but the installer tries to install both.
Because only the DLL that is required on a particular machine will be available,
the installer writes a fatal error to the log file if one of the DLLs is not found.

You can ignore this error message under certain conditions:

FluorineFx.dll is required if the following components are installed on a
machine:

Cataloger
Solutions

itextsharp.dll is required if the following components are installed on a
machine:

Cataloger

WebServices
MediaProcessor for InDesign
Solutions

MediaServer
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MediaProcessor for FLV Generator

If a DLL is required and it is not installed on the global assembly cache (GAC),
complete the following steps to put the files into the assembly:

If Microsoft Visual Studio is installed on the machine:

1 Enter the following command at the VS command prompt for Microsoft
Visual Studio: Sn -vr D11 Path. For example: Sn -Vr C:\GACDemo
\fluorinefx.dll.

2 Enter the following command at the VS command prompt for Microsoft
Visual Studio: Gacutil -i D11 Path. For example: Gacutil -i C:
\GACDemo\fluorinefx.dll

If you are working in Windows 7 or Windows Server 2008 R2 (64-bit SP1),
drag the DLLs to the assembily folder (C: \Windows\assembly).

If you are working in Windows Server 2012 R2, you can use the following
PowerShell script on Windows Server 2012 R2 to install the DLL to GAC.
The following example code adds FlourineFx to the GAC:

[System.Reflection.Assembly] : : Load

("System.EnterpriseServices, Version=4.0.0.0, Culture=neutral,
PublicKeyToken=b03f5f7f11d50a3a")

S$publish = New-Object System.EnterpriseServices.Internal.Publish
$publish.GacInstall ("C:\SASMOMTools\Fluorinefx.dl1l")

Running a Service under the MOMUSR
Context

The following services need to run under MOMUSR: SAS MOM Queue
Manager, Cataloger, BusinessEvents, PluginService, File Watcher, and Service
Monitor. If the installer fails to run these services under MOMUSR , complete the
following steps on each of these services in the Services applet:

1 Go to the Services panel by selecting Start » Administrative Tools
Server Manager, and then click Services.

2 Right-click on the service and select Properties.
3 Click the Log On tab.

4 Select the This account option.

5 Click Browse and select the MOMUSR account.
6 Click the General tab.

7 Select the start-up type as Automatic.

8 Click OK to apply the settings.

Note: On both the machines, MOMUSR needs to be given full control to the
installation folder.
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Setting the Event Log

When the SAS MOM Queue Manager Service is started on any machine, it
creates a SAS MOM event log on the event viewer. You should edit a property of
this event log so that the event log is never full.

To change the event log setting in the Event Viewer:

1

2

Start all the services on all the machines in your configuration.

Select Start » Administrative Tools » Diagnostics and click Event
Viewer.

In the left pane, right-click the SAS MOM log and select Properties.

Select Overwrite events as needed.

Display 8.5 Log Properties
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Create Shared Drive

A MediaProcessor folder is created on the web services and Media Server
machines after SAS Marketing Operations Management is installed. It is created
under the installation folder. On both the machines, share the folder, add
MOMUSR on the Security tab and the Sharing tab, and specify Full Control to
the user.

Note: Make sure the shared folder has the name MediaProcessor on both the
machines. Do not change the name.

Display 8.6 Personal Folder Properties
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Database Creation Fails

If database creation fails, you must create a separate database for each tenant.

Create Database for Tenant
1 Launch Microsoft SQL Management Studio.
2 Connect to the server by entering the database user credentials.
3 Inthe left pane, right-click Databases, and then click New Database.
4

In the New Database dialog box, enter the new database name and click OK.
The new database is now created.

Display 8.7 New Database
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Run the Database Scripts

Run the database scripts against the tenant database by connecting to the SQL
Server, using the new login that you created in “User Creation Fails-Configure
Windows User on the Server” on page 72. The database scripts are under
Installation Folder » Database » SQL Server.

Select the database and click File » Open » File>> and select the scripts from
the Installation Folder » Database » SQL Server. Click Open. Click Execute
and connect to the SQL Server using the login that you created for the database.

Note: Keep checking the database name to make sure the scripts are run on
the selected database.

Run the database scripts in the following sequence:
1 1_MOM_SQL_Scripts.sql

2 2 _MOM_Init_SQL_Scripts.sql

3 1_MOM _DB_Insert_Schema_Script.sql

Display 8.8 Database Scripts
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Create an ODS Database for the Tenant

After you complete the steps in “Create Database for Tenant” on page 81, you
must create another database. The mandatory convention for naming the ODS
database is DB Name for the Tenant_ODS.

Execute the following scripts for the ODS database:
1 1_ODS_DB Create_Script.sql
2 2 ODS _DB_lInsert_Script.sql

Creating Queues Manually

Queues are created when SAS Marketing Operations Management is installed.
If queues were not created, then you can create the queues manually. Run the
batch files Createqueues.bat file located under <Installation Folder
\Binaries.

The following queues are created:

On the solution or web server machine:
MEDIARESPONSEQ
UNDELIVEREDQ
REPLICATIONAGENTQ
AP_PREVIEWGENERATIONQ
WB_SOLUTIONSQ
EVENTQ
ALCHANGEMANAGEMENTQ

On the web services machine:
EMAILQ
MEDIARESPONSEQ
UNDELIVEREDQ
ALPROCESSMESSAGEQ
EVENTQ
ALINTERNALPROCESSQ
ALACTUALSQ
REPLICATIONSERVERQ
SIMULTANEOUSCHECKOUTQ
SEQUENTIALCHECKOUTQ
FILEMETADATAHANDLERQ
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COPYMOVEREQUESTHANDLERQ
ALESTIMATEQ
IMPORTJOBQ
COPYPLANQ
SIMULTANEOUSEVENTQ
ALCHANGEMANAGEMENTQ

On the InDesign Machine:
INDESIGNCS3Q
RESPONSEUNDELIVEREDQ
png_in
pnqg_out

FLV Generator Machine
RESPONSEUNDELIVEREDQ
APP_FLVGENERATORQ_SIM
DAM_FLVGENERATORQ_SEQ

Cataloger Machine
MEDIARESPONSEQ
UNDELIVEREDQ
UPDATEASSETPROCESSQ
CATALOGERJOBQ

Media Server
SEQUENTIALCHECKOUTQ
SIMULTANEOUSCHECKOUTQ
MEDIARESPONSEQ
UNDELIVEREDQ

Media Generator Machine
RESPONSEUNDELIVEREDQ
APP_MEDIAGENERATORQ_SIM
DAM_MEDIAGENERATORQ_SEQ

MS Office Processor Machine
MSOFFICEPROCESSORQ
RESPONSEUNDELIVEREDQ
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Deleting a Tenant

Gather Prerequisite Information

To gather the information required to delete the tenant:

1 Determine the name of the tenant database and the ODS database for the
tenant. Tenant and ODS database names for the tenant are available in the
Tenant Name.xml file on the web services server.

a Navigate to Tenant Name.xml in the Installation Folder
\Configuration\XML folder.

b In the Tenant Name.xml file, the value of the CONNECTIONSTRING
node contains the name of the tenant database. The value of the
CONNECTIONSTRINGFORODS node contains the name of the ODS
database for the tenant. The values are encrypted. To get the name of the
database, the value should be decrypted.

Note: The web page used to decrypt the value is not deployed with SAS
Marketing Operations Management. You must request the page from
SAS Technical Support.

Display 8.9 Tenant XML File

CCONFIGURATIONS
<DATABASE >
<CONNECTIONSTRING>UEMg514HkFreRiduozYevTwRadIdt8yQDjylizpZtmltr
LCUNNE s W * e6FXhNNhmLCER30YpYIx1CshTLEIWYC fpS

<CONNECTIONS TRINGFORODSSP >AZnEIEMKR jiKd+4BoIEiwe jpkriw03bpGyebBwp
<CONNECTIONSTRINGFORODS »goQekSDL/DcThyEYn9DTF JUdgf ImadGjs4NSKy
<RETRYSLEEPDURATIONS < /RETRYSLEEPDURATION>

<COMMANDTIMEQUT »18@</COMMANDT IMEQUT »

c After decrypting the values, check for the Initial Catalog parameter.
The value of this parameter is the database name.

Display 8.10 Initial Catalog Parameter

Data Source=172.26.77.68{nitial Catalog=MOM_DBj}|

2 Determine the Cataloger mount point, the secondary mount point, and the
external mount point that are configured for the tenant.

a Log on to the system in the browser and navigate to the Settings link in
the left pane under the Administration task pane.

b Locate the mount points in the Cataloger Settings section.
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Display 8.11 Cataloger Settings

A Cataloger Settings

Hote: = Any changes to these settings will require Cataloger and Filewatcher services to be restarted.
=+ Cataloger MountPoint must be a shared folder on the Cataloger machine.
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* MountPoint: |\\.1 7.5.8.9\WMOUNT_POINT\Catalog er_{

* secondary MountPoint: [\17.6.8.2WOUNT_POINT\Cataloger | @
External MountPoint: | | @

Retry Count: |: |

Note:

The Secondary MountPoint is available if SAS Marketing Operations
Management is set up with two catalogers.

If the specified path is a non-UNC path, then the MountPoint and
Secondary MountPoint are on the Primary and Secondary Cataloger
servers respectively.

If the specified path is a non-UNC path, then the External
MountPoint is on the server on which the SAS Marketing Operations
Management DAMJobCopy Service is installed.

3 Determine the network folder path for the tenant.

a Log on to the system in the browser and navigate to the Settings link in
left pane under the Administration task pane.

b Locate the network folder path in the DAM Settings section.

Display 8.12 DAM Settings
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4 Determine the Format Watcher mount point, and the Invoice mount point and
archive file path for the tenant

a Log on to the system in the browser and navigate to the Settings link in
the left pane under the Administration task pane.

b Locate the Format Watcher Mount Point in the Format Watcher Settings
section.

Display 8.13 Format Watcher Settings

4 Format Watcher Settings

Note: Any change to this setting wil require Format Watcher service to be restarted.

* Format Watcher Mount Point:  [CASASMOM\Format Watcher Mount |

Note: Format Watcher Mount Point is found on the web server.
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5 Locate the Invoice Mount Point and Archive File Path in the Import Invoice
Settings section.

Display 8.14 Import Invoice Settings

A Import Invoice Settings

Invoice MountPoint:  [CASASMOMnvoice Mount Point | @
Archive File Path: | | @

Send Motification for Imported Invoices: Mo = @

Email Ids for Imported Invoice Notification: | | @

Note: If the specified path is a non-UNC path, then the Invoice Mount Point
and the Archive File Path are on the web services server.

6 Determine the mount point and the XML mount point for the tenant.

a Navigate to Installation Folder\Configuration\XML on the web
services server and open Tenant Name.xml.

b In the XML file, check the values for the MOUNTPOINT and
XMLMOUNTPOINT nodes. These values are the paths of the mount point
and the XML mount point configured for the tenant.

Display 8.15 XML Mount Point
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Note: If the specified path is a non-UNC path, then the MountPoint and
XML MountPoint are on the web services server.

7 Determine the vaults for the tenant.

a Log on to the system in the browser and navigate to the Digital Library
link in the left pane under the MOM task pane.

b In the Digital Library, click the Vaults link in the left pane under the
Administration task pane.
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Display 8.16
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Cc

Locate the system vaults and the vault specified for Artwork Producer on
the web services server. Locate the name of the vault used for Artwork
Producer in the Tenant settings.

Display 8.17 Artwork Producer Settings

4  Artwork Producer Setfings

*Vault Name:

Artwork Producer

* Format Definition Section Hame:

" Generated Artwork Section Name:

Delete a Tenant

Note: If the path specified for a non-system vault is a non-UNC path,
then the vaults are on the web services server. If Media Server is
configured for the tenant, then the vaults are on the Media Server.

To delete a tenant:

1 Stop all the SAS Marketing Operations Management Windows Services on
all the servers used for the deployment. Stop the IS service on the web
server, web services server, and Media Server.

2 Delete the following for each tenant:

Cataloger Mount Point, Secondary Cataloger Mount Point, and External
Mount Point.

Format Watcher Mount Point, Invoice Mount Point, and Archive File Path
Network Folder path

Mount Point and XML Mount Point

Vaults

3 Delete the Tenant Name application from 1S on the web server. Navigate to

Start » Administrative Tools

Internet Information Services and

remove the Tenant Name application.

4 Remove the tenant reference from the Assetlink.xml on the web services
server.
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a Navigate to Installation Folder\Configuration\XML folder and
open Assetlink.xml.

b Delete the Tenant Name node.

5 Remove the tenant folder from the installation folder on the web server and
the web services server.

a Navigate to the Installation Folder.

b Delete the Tenant Name folder and the Tenant Name file exchange folder.

Display 8.18 Tenant File Exchange Folder
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6 Remove the cache files for the tenant from the application server.
a Navigate to the Installation Folder\OMCACHE folder.

b Delete all the files that start with the Tenant Name.

Display 8.19 Tenant Files
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7 Remove the databases for the tenant from the Database Server:

a Navigate to SQL Server Management Studio.

b Delete the tenant database and the ODS database that were created for
the tenant.



90 Chapter 8 / Troubleshooting

Display 8.20 Tenant and ODS Databases
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8 Remove the tenant reference from the Framework_Tree.xml file on the web
server:

a Navigate to Installation Folder\Configuration\XML folder and
edit FrameWork_Tree.xml.

b Search for the Tree node that has the tenant name as the value for the
text attribute, and delete that node.



Display 8.21 Framework Tree
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9 Remove CreateTenant_Tenant Name.ixt from the web server. Navigate to
the Installation Folder folder and delete CreateTenant_Tenant Name.txt.

10 If SAS Marketing Operations Management and Marketing Automation have
been integrated, then remove the Tenant Name_QuickStart wsdl.dll from the
web server:

a

If SAS Marketing Operations Management and Marketing Automation
integration is configured for a tenant and the WSS feature is set to Yes,
then navigate to Installation Folder\Binaries folder and delete
Tenant Name_QuickStart wsdl.dll.

You should remove the security certificate that is installed on the SAS
Marketing Operations Management Web Server for this tenant:

a

b

Open a command prompt window.

Type mmc and press Enter. To view the certificates in the local machine
store, you must be an Administrator.

On the file menu, click Add/Remove Snap In.
Click Add.

In the Add Standalone Snap-in dialog box, select Certificates.
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f Click Add.

g In the Certificates snap-in dialog box, select Computer account and
click Next. You can select My User account or Service account. If
you are not an administrator of the computer, you can manage
certificates only for your user account.

h In the Select Computer dialog box, click Finish.
i Inthe Add Standalone Snap-in dialog box, click Close.
i Inthe Add/Remove Snap-in dialog box, click OK.

k In the Console Root window, click Certificates (Local Computer) to
view the certificate stores for the computer.

I Inthe tree view, expand Personal » Certificates. In the details
section, a certificate installed for MOM-MA integration is listed. Select
the certificate and delete it.

Display 8.22 Certificates
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Note: In this example, client.test.com is the name of the certificate. The
name of your certificate might differ based on the name that was specified
when the certificate was installed.

m In the tree view, expand Trusted People » Certificates. In the details
section, a certificate installed for MOM-MA Integration is listed. Select
the certificate and delete it.
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Display 8.23 Certificates
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Note: In this example, client.test.com is the name of the certificate. The

name of your certificate might differ based on the name that was specified
when the certificate was installed.

Configure a Virtual Directory for the
Tenant

The virtual directories are created automatically during installation and tenant
creation. If it fails, create a virtual folder named <Tenant Name> that points to

Installation Folder\Tenant Name folder as its physical path. Then
configure the virtual folder.

Configure the Virtual Directory

Go to the IIS Manager (select Start » Administrative Tools » Internet
Information Services (IIS) Manager). To create virtual directories:

Right-click Default Website and select Add Application. Add a new application
by entering the alias (the tenant name), and enter the path Installation
folder\tenant name. Click OK to save the information.
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Display 8.24 Virtual Directory Configuration
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To configure a virtual directory for each tenant:

1 Ensure that in the Default Document window, the document default.aspx is
present and at the top.

2 Double click the HTTP Response Headers icon. The HTTP Response
Headers window appears. Right-click on the screen, and select Set
Common Headers. Select Expire Web content and After, and enter the
number of days.

Note: If you have an HTTPS setup for an installation, set the web content
expiration to 1 or more days in the IS for the tenants.

Display 8.25 Virtual Directory Configuration
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3 To configure new MIME types, double-click the MIME Types icon. Click Add
in the right pane. Add the new MIME types with the following extensions:
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Table 8.1 Extensions

Associated Extension Content Type (MIME)

.axd text/plain

.Css text/css

.gif image/gif

Js application/x-javascript

xpdl text/plain

fiv video/x-flv

.SWz application/x-swz

.air application/vnd.adobe.air-application-

installer-package+zip

Note: You should clear the browser cache after any new installation.

Create a Virtual Directory for Dashboard

Create a virtual directory named Dashboardimages. See “Configure the Virtual
Directory” on page 93 for information about creating a virtual directory. Give
Read access to the virtual directory. The virtual directory should be created on
the Solutions machine (web server).

You must create this virtual folder on the web server machine where SAS
Marketing Operations Management solutions are installed. On a single-machine
configuration, the Dashboardlmages virtual directory should point to the Outbox.
In a multi-machine configuration, OutBox is created on the Service Machine. On
the Solutions machine, you must manually create a Dashboardlmages folder
and point this to the virtual directory of Dashboardlmages.

Creating the Desktop Folder

Create a Desktop folder (if one has not already been created) at the following
location:

WindowsInstallationDir\System32\config\systemprofile\
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Working with Applicati
Manager

Create Application Pools

on Pools in IIS

If the creation of the application pool fails, you must manually create the
application pool:

1 Go to Internet Information Services(lIS) Manager.

2 Right-click Application Pools and select Add Application Pool.
Display 8.26 Add Application Pools
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3 Enter sasMOMAppPool for the name.

4 Select .Net CLR Version v4.0.30319 for .NET CLR version.

5 Select Classic for the Managed pipeline mode.
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Display 8.27 Add Application Pools
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6 Select the newly created SASMOMAppPool and click Advance Settings in
the right pane.

Display 8.28 Application Pools

e’a‘ Application Pools -~
| { Add Application Pool...
This page lets you view and manage the list of application pools on the server. Application pools are associated with worker processes, contain one of mare applications, and provide isolation ameng different Set Application Pook fefa
applications, Application Pool Tasks
Fiter: ¥ Go - GShowAll |Group by: No Grouping . :
— — — — Stoj
Name * Status  .NETCLRV.. ManagedPipel... ldentity Applications s FE:ﬁ_
D NETvAS Started 4.0 Integrated ApplicationPoclld.. 0 bt 1o
LD NETv4.5 Classic  Stated 40 Classic ApplicationPoolld.. 0 _ Edit Application Pool
(D DefaultAppPool  Started  v4.0 Classic LocalSystem 2 [E Basic Settings...
{f SASMOMAppP... Started  vA.0 Classic AlUser g 1 Recycling...
Advanced Settings.
Rensme
K Remove
View Applications
| @ Hep

7 Change the value of Regular Time Interval (minutes) to 0.

Note: If the creation of SASMOMAppPool also failed during the installation
process, you must also manually configure SASMOMAppPool.

Configure Applications in the Application Pool

If the configuration of applications for the application pool fails, you must
manually configure them.

1 Select the website (each website created by the SAS Marketing Operations
Management application) and click Basic Settings in the right pane. The
Edit Application dialog box appears.
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Display 8.29 Basic Settings
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2 Click Select to change the application pool.

The above steps need to be done on the following servers and their respective
applications (websites):

Solutions
Tenant
Dashboardimages
ALlIntegrationServices
ALServices
SASMOMJS

Web Services
ALServices

Cataloger
ALServices
ADCataloger

Media Server
ALMediaServices
ALServices

Microsoft Office Processor

ALServices

Verify Complete Access for MOMUSR

Verify that MOMUSR has complete access on all private messaging queues
(MSMQs). Go to Programs and right-click Computer. Expand Features
Messaging Queues » Private Queues. For all the SAS Marketing Operations
Management queues, verify that MOMUSR has complete access by right-
clicking on each of the queues and clicking the Security tab.
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Configuring Scheduled Tasks

Schedule the Utility

Note: The scheduled tasks are created automatically. Please check to
determine whether the scheduled tasks are created.

To schedule the utility:

1

Select Start » Programs » Accessories » System Tools » Task

Scheduler.
Right-click Task Scheduler (Local) and select Create Task.

Click the General tab and enter and name for the task. Select Run whether
user is logged on or not.

On the Triggers tab, click New and schedule the task by setting the time at
which the task needs to run.

On the Actions tab, click New. Browse and select the .exe file located in
Installation folder\Binaries.
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6 The default settings need to be used on the Conditions tab and the
Settings tab.

The utility is now scheduled and will automatically run every day at the time
that you specified. The following utilities are scheduled using the above
process:

Schedule Task for Digital Library
Security Policy Report Generation for Digital Library
DAM Vault User Access Report Generation

Schedule Task for Digital Asset Manager

Schedule AL_DAMBackGroundRequestHandler.exe to run at a time when there
is little or no activity on the server. This exe is located in Installation
Folder\binaries. It has to be added as a scheduled task on the web services
machine.

This task should be scheduled to run at a time when the fewest users are logged
in to the system. It needs to be run at a time when the system is not due for
restart. This operation takes a while to execute, so ensure that there is sufficient
time between the start of the task and the restart of the system.

Perform the following three operations:

Recycle Bin cleanup: To empty the recycle bin of content that is marked for
permanent deletion.

For marking the assets as expired: To mark assets that have an expiration
date that is before the current date.

Note: This task should be scheduled to be run after 12.00 a.m. This
operation takes a while to execute.

To calculate the total disk space usage by the Vaults: To calculate the
total space used by the vaults in Digital Asset Manager.

To change the application behavior, the following parameters need to be set in
the AL_DAMBackGroundRequestHandler.exe.config file:

SENDEMAILFORVAULTDISKSPACE
If the total used disk space percentage for the vault is greater than the
configured number, then notification specifying disk space details for the
vault are sent to the System Administrator and the configured users,
depending on the value specified for this configuration. By default, the value
IS true.

NOTIFYIFUSEDDISKSPACEPERCENTAGEGREATERTHAN
Number specifying the percentage allowed for total used disk space. By
default the value is 8o0.

EMAILIDSFORVAULTDISKSPACENOTIFICATION
Comma-separated email IDs of users who should be notified.
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Display 8.31 Parameters
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Schedule Security Policy Report Generation for
Digital Library

To generate data for a Security Policy report, the SecurityPolicyService.exe
application needs to be scheduled to run periodically. The default interval is 3
hours. Create a schedule task for this application. This exe is located in the
Installation Folder\binaries folder. It has to be added as a scheduled
task on the web services machine.

Schedule a DAM Vault User Access Report
Generation

This report is used to get information related to user’s access to vaults in the
system. It’s an off line report that is used to populate a temporary table in the
database, which is used by the report to display data. To generate data for a
DAM Vault User Access report, the DAMVaultUserAccess.exe application needs
to be scheduled to run periodically. The default interval is 3 hours. Create a
schedule task for this application. This exe is located in the Installation
Folder\binaries folder. It has to be added as a scheduled task on the web
services machine.

Checking Logs for Errors

After installation, if any errors occur while using the SAS Marketing Operations
Management system, you can check the logs at the following locations:

On the Solution machine, the logs are located at Installation folder
\Logs and Installation folder\Tenant Name\Logs\Exception

On the web services machine, the logs are located atInstallation
folder\Tenant Name\Logs, Installation folder\Logs, and
Installation folder\MediaProcessorLog

On the Cataloger machine, the logs are located atInstallation folder
\Tenant Name\Logs, Installation folder\Logs, Installation
folder\Errors, and Installation folder\MediaProcessorLog

On the InDesign machine, the logs are located at Installation folder
\Logs and Installation folder\MediaProcessorLog
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